Note: This document describes the state of the Synclavier® Digital Audio System as of October, 1994. Software updates issued since that time are not described in this manual but are documented elsewhere.

Synclavier Digital does not, at this time, offer any Synclavier® hardware or systems for sale. Please visit our website at www.synclavier.com to learn more about the rebirth of this remarkable instrument.

Synclavier Digital, February 2006
Contents

Chapter 1: Getting Started

Where Do I Start?
  How Do I Use The Manuals? ........................................ 2
  Words of Wisdom .................................................... 4
System Overview
  System Configurations ........................................... 5
  Hardware Overview ............................................... 7
  Booting the System .............................................. 8
Applications and the Macintosh
  The Audio Production Process .................................. 9
  The Macintosh Interface ......................................... 9
  The RTP Interface ............................................... 10
  Applications ..................................................... 11
  Help ........................................................................ 11
  Memory Management ............................................ 12
Time Displays and Motion Controls
  Time Displays .................................................... 13
  Motion Controls .................................................. 13
  Key Mapper ....................................................... 14
TransferMotion Menus
  File Menu ......................................................... 16
  Edit Menu ........................................................ 16
  Window Menu .................................................... 16
  Display Menu .................................................... 17
  Settings Menu .................................................... 17
EditView Menus
  File Menu ......................................................... 18
  Edit Menu ........................................................ 18
  Window Menu .................................................... 19
  Events Menu ..................................................... 19
  Controls Menu ................................................... 19
  Times Menu ...................................................... 20

Chapter 2: Tutorial for the PostPro

Projects
  Opening a Project .................................................. 22
  Creating a Project ................................................ 23
Recording
  Setting the Record Parameters ................................ 24
  Cue Recording .................................................... 25
Editing Cues
  Viewing Cues ...................................................... 27
  Trimming a Cue ................................................... 28
  Other Editing Features .......................................... 29
Chapter 3: Recording & Editing with the PostPro

Tracks and Projects
- DTD Tracks ................................................................. 36
- What is a Project? ...................................................... 37
- Opening a Project ...................................................... 37
- Creating a Project ...................................................... 38
- Deleting a Project ...................................................... 39

Basic Recording
- Track Parameters ...................................................... 40
- Cue Recording .......................................................... 41
- Auto Functions .......................................................... 44
- Cue Punch Recording .................................................. 44
- Mark Points .............................................................. 45

Advanced Recording Features
- Optical Transfer ....................................................... 47
- Poly Transfer ............................................................ 48
- Time Scale Modification .............................................. 48
- Bouncing DTD Tracks ................................................. 50
- Cue Bounce ............................................................. 52

Digital Transfer
- Synchronization and Sampling Rate ......................... 53
- Non-Drop Time Code and Color House Sync ............... 54
- Monitoring Tracks ..................................................... 54
- Digital Transfer Settings ............................................. 54
- Digital Transfer Out .................................................. 56
- Digital Transfer In ..................................................... 57

External Synchronization
- Synchronization Preferences ..................................... 58
- Machine Control ....................................................... 58

Backing Up
- WangDAT™ Tape Drive ........................................... 61
- Project Backup ........................................................ 62
- Track Backup .......................................................... 62
- Verifying the Tape Backup ......................................... 63
- Storing and Recalling Cue Directories ....................... 63
- Storing and Recalling Individual Cues ....................... 64
- Recalling Projects .................................................... 65
- Recalling Tracks ....................................................... 67
Chapter 4: Sequencing

Displaying Sounds
Selecting a Volume ........................................... 68
Viewing Sound Information .................................. 69
Selecting and Auditioning Sounds .......................... 70
Searching ...................................................... 71
Librarian Index Files ........................................ 72
User Index Files ............................................. 74
Printing ....................................................... 75

Cue Editing
Recalling and Displaying a Cue .............................. 76
Cue Playback .................................................. 77
Trimming a Cue ................................................ 78
Saving and Protecting Cues .................................. 79

Advanced Cue Editing
Edit Points ..................................................... 80
Editing Features .............................................. 81
Using a Command ............................................ 82
Blocking ...................................................... 83
Pasting with Leader ......................................... 84
Sliding ........................................................ 84
Adjusting the Volume Envelope ............................ 86

Chapter 4: Sequencing

Displaying EditView
Tracks Display .................................................. 88
EditView Track List ........................................... 89
Tools .......................................................... 90

Placing Cues
The Place Button ............................................. 91
Placing ........................................................ 91
Auto Placing .................................................. 92

Event Editing
General Editing ............................................... 93
Trimming an Event .......................................... 95
Aligning an Event ........................................... 95
Editing Time Fields ......................................... 96
Volume Envelope ............................................ 96
Advanced Event Editing Commands ....................... 97

Region Editing
Setting In and Out points ................................... 98
Using Edit Commands ....................................... 99

Playback
Motion Controls .............................................. 100
Scrubbing ..................................................... 101
Solo and Mute ............................................... 102
Mark Point .................................................... 102
Output Routing .............................................. 102
Chapter 5: Autoconform

Introduction

- Opening an EDL .......................................................... 104
- The Autoconform Window ........................................ 105
- The Reel List ............................................................ 106
- The EDL ..................................................................... 106
- Motion Controls .......................................................... 106

Setting Up To Record

- Editing the EDL ............................................................ 107
- Track Assignments ....................................................... 107
- Checkerboarding ........................................................ 107

Recording

- Recording Preferences ................................................ 111
- Recording ..................................................................... 113
- Recording Multiple Takes .......................................... 114
- Rehearsing Events ....................................................... 114
- Using the Stramp SR System ....................................... 115
- Erasing Audio ............................................................. 116

Conforming

- Turning the EDL into a Sequence ............................... 117
- Merging Events .......................................................... 117

Menus

- File Menu ................................................................. 119
- Edit Menu .................................................................. 119
- Window Menu .......................................................... 119
- Events Menu ............................................................ 120
- Record Menu ............................................................ 120
- Conform Menu .......................................................... 120
Chapter 1
Getting Started
Where Do I Start?

To get started, all you need to know is a few basics. By the time you finish this chapter, you will be ready to complete the Tutorial in the next chapter.

This manual assumes you have some familiarity with the Macintosh. If you are new to the Macintosh, we suggest you go through the training disk, Macintosh Basics, and the tutorial book, Learning the Macintosh, that came with your Macintosh, before you read this manual.

How Do I Use The Manuals?

The four manuals contained in the Documentation Set are organized according to the kinds of work you do with Synclavier Company products—hard disk recording and editing, sound design and music sequencing, file management, and so forth.

Manual I: PostPro Production System

This manual contains a tutorial that quickly orients you to the PostPro system. It gives step-by-step instructions for using the hard disk recording, editing and sequencing system. It also describes the Autoconform software.

Manual II: Music Production and Sound Design

This manual contains a tutorial that quickly orients you to the sound design and recording features of the Synclavier. It includes instructions for using the Synclavier keyboard, the VK panel and the RTP screens for sound design and sequence creation and editing.


This manual contains reference information for entire system, including installation, storage, utilities, the RTP displays, external synchronization and hardware specifications.

Manual IV: Sound Libraries

This manual contains Synclavier Digital Music Library and any other sound libraries that you purchase. It contains minimal instructional material. It is mainly used as a reference to sounds on your optical disks, hard disks, and floppy disks.
The first three manuals provide step-by-step instructions for the features described. To locate additional information about a topic, you can either look through the extensive table of contents in the front of each manual, which lists the major topics, or consult the comprehensive index at the back of each manual, which lists tasks, commands, hardware components, displays, and other specific topics.

Three icons are used throughout the manuals to direct you to information—

“Notes” give you additional information related to the topic being discussed. Sometimes they direct you to other sections of the manuals for additional information. Often there is more than one way to perform an operation. For example, you can record to the hard disks from two different software applications. We provide you with step-by-step instructions for one method, but you may find others in a Note adjacent to the instructions or in the Reference Guide.

“Hints” are shortcuts that will help you do your work. They have been collected from Synclavier Company personnel and experienced customers, and are included here to help you work as quickly and efficiently as possible.

“Warnings” alert you to operations that may cause unexpected or negative results. If you are reading a section that contains a warning sign, don’t proceed with the operation until you have read and understood the warning. If you have additional questions, call Synclavier Digital Support Services before proceeding.

Often there is more than one way to perform an operation. For example, you can record to the hard disks from two different software applications. We provide you with step-by-step instructions for one method, but you may find others in a Note adjacent to the instructions or in the Reference Guide.
Words Of Wisdom

The following concepts occur frequently throughout these manuals.

**Digital**  Synclavier Digital system is a digital system which represents sounds digitally and stores them on digital storage media.

**Random access**  This means you can play any audio at any time, without shuttling tapes. Synclavier Digital’s non-linear random access editing system lets you assemble audio in any order. You can rearrange or edit audio at any stage in the editing process.

**RAM**  RAM is a temporary memory storage area in your Macintosh. Poly RAM is a temporary memory storage area in your Synclavier computer.

**Cue**  When you record onto the DTD, audio is digitized onto hard disks and becomes source audio. A cue points to a segment of audio on the source tracks which becomes a reference for playing and editing.

**Sound file**  When you record or sample sounds into poly RAM, they are stored as sound files on the system hard disk or optical disks.

**Event**  An audio event is any type of sound that has been placed in a sequence.

**Sequence**  A sequence is where all audio events, including cues, RAM events, notes or MIDI, are organized in time and triggered at a precise moment.

**Project**  A designated area on the DTD where cues are recorded. The amount of time available depends on your system configuration. In a standard configuration, each track contains one hour of recording time. All audio for a particular job is stored in a project.
System Overview

Synclavier Digital sells systems in a variety of hardware configurations. Although these systems can differ greatly in capability and size, they have some general things in common.

System Configurations

All Synclavier Company systems have a Macintosh computer, which is attached to a Synclavier computer, a Direct-to-Disk (DTD) computer, or a combination of both. The diagram below shows the hardware layout of the most common configurations.

For more information on hardware configurations, see the Reference Guide.
Regardless of your system configuration, all the software and hardware in your system is has one goal: the creation of a **sequence**. A sequence is simply a list of start and end times for audio events. A sequence can be played and edited, saved as a file, and recalled later for playback or further editing.

Your specific configuration determines the type of audio and the degree of control you have when creating a sequence.

- the **hardware** determines the type of sound you can record or generate, and how much of that sound can be played back at one time.
- the **software** determines how many editing, recording and processing features you have.
- the **storage** options determine how much on-line sound data is available while you are working.

Below is a diagram showing what type of elements each of the two product areas contributes to the sequence creation process.

The primary interface for editing and viewing sequences is Syclavie Digital’s Macintosh applications **Editview** and **TransferMation**. Their graphical layout makes it easy for the inexperienced operator or client to see and understand what is happening, yet it also provides the experienced user with a comprehensive and powerful set of audio editing features.

Editview provides a consistent interface for editing all types of audio events. The blocks on the screen can represent musical notes, sound effects or sections of dialog, but they are all edited in the same way, regardless of where the audio was generated from or where it is currently stored on the system.
The other major software component is the **Real-Time Program (RTP)**. The RTP controls the operation of all the hardware, including both the Synclavier and the DTD. The RTP communicates with Synclavier Digital’s Macintosh applications via R-S422 protocol.

Combining the Macintosh graphical user interface with the real-time audio capabilities of the hardware creates a Synclavier and Direct-To-Disk product line that is easy to use, powerful and efficient.

### Hardware Overview

It is helpful to have a basic understanding of your hardware, and therefore understand how it affects the operation of your software. Synclavier Digital manufactures a variety of system packages. Your system might include one, two or several Synclavier Company machines. However, all systems have the same logical organization of hardware and software. Below is a diagram of the major hardware components present in each Synclavier Company system.

All systems contain the shaded portions of the picture. The main computer where the RTP runs, controls the operation of all other Synclavier Company hardware components. A hard drive is located with the system software, and a superfloppy drive is used to start up (boot) the system and get the RTP running. The RTP controls all communication with the Macintosh computer.
The polyphonic sampling RAM (poly RAM) is used for sound file recording, editing and playback. It is only present if you have a Synclavier or a PostPro SD. Standard configurations contain between 32 to 96 megabytes of poly RAM.

The system components on the right side of the above diagram are present only if you have the DTD option. The DTD operating system runs on a second computer, which controls all operations concerning the DTD audio, hard drives and tape backup system. As a user, you are not directly aware of this second computer, because all access to it is controlled by the RTP.

## Booting the System

The following steps explain how to start your Synclavier Company hardware and software.

1. Power up all your hardware units first. This includes the Synclavier, PostPro, Macintosh, monitor, storage disks and backup units.

2. To boot the Macintosh, press the Power On key in the upper right corner of the keyboard. Wait for the Finder Desktop to appear.

3. Double-click the NED StartUp icon to open its window.

4. Insert the 5.25" Bootload Disk into the superfloppy drive. Turn the lever down and press the red load button on the drive.

   A series of messages appears on the screen during loading. If a ready prompt (Ready>) appears on the screen, type the command `play` and press the Return key. When the system is started, the Main Menu of the RTP appears. If you have a Direct-To-Disk, wait until the system software has loaded and each drive had been turned on before doing anything else. This can take several minutes.

5. To start an application, select the application's name from the Window menu.

Once you have booted the system, remove the Bootload Disk from the superfloppy drive, until you need to reboot. This guards against accidental destruction of your bootload disk.
Applications and the Macintosh

Synclavier Company applications open many different windows, each with its own set of functions. TransferMation contains the Librarian, the Patch Bay, and the Transport Controls. EditView has its own window. Another set of displays that you will frequently encounter are the RTP displays. The RTP contains a set of windows that in some places contain functions not available in TransferMation or EditView.

The Audio Production Process

Non-linear audio production allows the person doing the assembly of audio elements to be in the final mix stage and still go back and quickly edit or change an original audio element and replace it. This type of integrated production process is possible because PostPro technology maintains the original audio unaltered through every stage of the production process.

The PostPro system is powerful because it can manipulate many types of audio from many different sources, and treat them as equivalent objects. The Audio Events are the raw material that make up a complex mix. These “blocks” of audio can be catalogued, recalled and individually edited, independent of time or in sync with other audio.

A Sequence is where all audio events are organized in time. Placed in time and context with other events, audio events become part of the final mix. The process of building a sequence involves adding audio events and editing them in time. The power and flexibility of the PostPro allows the user to perform these tasks in any order.

You will primarily be working in the applications EditView and TransferMation. These audio production software applications are used for record, edit, and arrange. You can display any or all of these windows in any configuration to match the type of work you are doing. The size and placement of the windows is defined by you.

The Macintosh Interface

Some applications have a Macintosh graphical interface. Applications such as EditView have the look and feel of Macintosh applications and dramatically improve the performance and usability of the Synclavier and DTD.

The most commonly performed tasks have been incorporated into the Macintosh software. However, you must continue to use the RTP displays to accomplish some system tasks.

The Transformation and EditView have menu bars at the top of the screen when each application is running. This menu bar is always available whenever the application is active.

EditView menu:
### TransferMation menu:

- **File**
- **Edit**
- **Window**
- **Display**
- **Settings**

The TransferMation menu contains all of the commands used by the individual TransferMation windows: Transport, Library, and Patch Bay. Occasionally a command is only relevant when a particular window is active. In that case, the command will be greyed out, which means it is temporarily unavailable. You can make the command available by activating the window it relates to.

---

### The RTP Interface

The Real-Time Program (RTP) is the operating system for all Synclavier Company applications. There are many displays that allow you to use all the RTP features. These displays are accessed through the NED StartUp program. When you launch NED StartUp, the Main Menu appears, and from this menu you can access all features available from the RTP.

<table>
<thead>
<tr>
<th>Directories</th>
<th>Main Menu</th>
<th>Memory Recorder</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Timbre Directory</td>
<td></td>
<td>S. Sequence Editor</td>
</tr>
<tr>
<td>B. Sound File Directory</td>
<td></td>
<td>G. Recorder Display</td>
</tr>
<tr>
<td>C. Sequence Directory</td>
<td></td>
<td>H. Multichannel Display</td>
</tr>
<tr>
<td>D. Subcatalog Directory</td>
<td></td>
<td>J. Midi Display</td>
</tr>
<tr>
<td>M. Missing Sound Display</td>
<td></td>
<td>K. Music Notation Display</td>
</tr>
</tbody>
</table>

**Sound Design**

- L. Sound File Editor
- F. FM Timbre Display
- I. Patch Display
- N. Name Keyboard Timbre

**Direct-To-Disk**

- O. Project Directory
- P. Track Display
- Q. Audio Event Editor

**Sound Archival**

- A. Optical Disk Storage

**System Control**

- E. Extra System Commands
  - <PF1> Reverse Compiler
  - <PF3> Music Printing
  - <PF1> SFM
  - <BREAK> Monitor
Applications

Syncclavier Company applications should be installed on the top level of your Macintosh hard disk. The Install program shipped with each software release automatically installs the software in the correct locations.

NED StartUp accesses the RTP, which performs functions such as recording, synchronization, track management and editing. The Main Menu appears when the RTP is started.

TransferMation contains a Librarian window for database management of sounds, a Patch Bay window for signal routing and a Transport window with motion controls. All of these windows are part of a common application and share a common menu bar.

EditView is a graphical interface for building sequences and editing events.

MIDInet is a multiport MIDI routing and processing unit designed to interface with the Syncclavier and PostPro.

Autoconform is used to import and edit an EDL from a video editor and record required audio onto the DTD for conforming into a sequence.

Help

The Help window serves as a quick reference for the TransferMation window. It is available at all times, and does not interfere with any functions. Select Help from the Window menu, or press the Help key on the keyboard to toggle the window on and off. You can also close the window by clicking its Close box.

The Help window tracks the cursor location and displays information about any TransferMation feature the cursor is over. You do not have to click to view information; it is displayed automatically.

Record button. Begins DTD recording when a DTD track is ready. See Record menu.
- Record modes: ALLOCATE and CUE PUNCH
- Triggers: AUTO and MANUAL

Key equivalent: Ctrl-0
Memory Management

When an application (such as TransferMation or EditView) is loaded, a specific amount of computer memory is allocated for its operation. In most cases this is more than sufficient for operation. If you are working with a large sequence or many events, you may find your system slowing down or running out of memory. In some cases, if the memory requirement is increased, this can enhance certain operational aspects of the application.

To check the memory allocation for an application, click once on the application icon and choose the command Get Info (-I) from the File menu.

A “Suggested” memory size is given at the bottom. You can increase this by typing a new number into “Current size.” Try increasing the current size by increments of 500 K. Restart the application and see if this makes a difference. In some cases it can enhance application operation.

The amount you increase the application’s memory allocation may depend on how much memory you have available. To check the total amount of memory available in your system, click on the Finder Desktop and pull down the Macintosh Apple menu. Select the About command at the top of the list. The dialog shows the “Total Memory” available and how it is currently being allocated.
Time Displays and Motion Controls

The following are time displays and controls present in the TransferMation application.

Time Displays

The left half of the Transport window contains the prominent current time display. This is where the sequence is currently located, and generally reflects the EditView cursor location. The current mark point time is below the current time.

Enter a new time into a time field by clicking in the time field and dragging or tabbing to a subfield and typing a new time. Double-click to select the entire time field.

You can jog the time by clicking and holding the time and dragging up and down with the cursor. Jogging the time field in this way jogs the lowest subfield.

Change the format of all time fields by pulling down the Display menu and selecting Seconds, Beats, Measures:Beats, Feet:Frames, Minutes:Seconds, SMPTE Mode or Feet Mode.

Motion Controls

Motion controls are located on the left side of the Transport window. They include Play, Stop, Fast Forward, Rewind and Record. These are activated by click them.
Getting Started

Time Displays and Motion Controls

Key

<table>
<thead>
<tr>
<th>Key</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>F9</td>
<td>Play from selected handle or time field</td>
</tr>
<tr>
<td>F10</td>
<td>Stop</td>
</tr>
<tr>
<td>F11</td>
<td>Play to selected handle or time field</td>
</tr>
<tr>
<td>F12</td>
<td>Audition the event or region</td>
</tr>
<tr>
<td></td>
<td>Continue</td>
</tr>
<tr>
<td>Control ↑</td>
<td>Locate to mark</td>
</tr>
<tr>
<td>Control ↓</td>
<td>Stop</td>
</tr>
<tr>
<td>Control →</td>
<td>Fast Forward*</td>
</tr>
<tr>
<td>Control ←</td>
<td>Rewind*</td>
</tr>
</tbody>
</table>

*Increase the speed 2x, 8x or 32x by clicking the arrow key 2-4 times.

Key Mapper

A set of quick keyboard commands has been preassigned to specific operations. The user can change these assignments by selecting Key Mapper... from the Settings... menu. The Key Mapper assignments work whenever TransferMation is the current application.

The list of functions that can be mapped to one or more keys is on the left. The keys preassigned to the operations are on the right. To change a key assignment, select an operation and press the actual key assignment. For example, if you want to initiate playback by pressing the Spacebar, select Play from the Key Mapper list and then press the Spacebar.
When TransferMation is first opened, the default Key Mapper commands appear. Recall a customized file of commands using the Open… command. These are active as long as TransferMation is open.

The user can save and recall alternate Key Mapper files for different types of work. KeyMapper files are saved on the Macintosh. Use the buttons on the right to manage your Key Mapper files.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open…</td>
<td>Recall a customized Key Mapper file.</td>
</tr>
<tr>
<td>Save</td>
<td>Save any changes made to the current Key Mapper assignments.</td>
</tr>
<tr>
<td>Save As…</td>
<td>Save the current key commands under a different file name or in a different location.</td>
</tr>
<tr>
<td>Default</td>
<td>Recall Synclavier Digital default Key Mapper settings.</td>
</tr>
<tr>
<td>Clear</td>
<td>Clear the selected Key Mapper assignment.</td>
</tr>
<tr>
<td>Clear All</td>
<td>Clear all Key Mapper assignments in the current file.</td>
</tr>
</tbody>
</table>
TransferMation Menus

The following is an explanation of the menu commands that are available when TransferMation is active.

File Menu

**New** -N Opens a new Librarian window.
**Close** -W Closes the Librarian
**Save As Text** Save a Librarian index file or the results of a search to a text file.
**Import Text File** Import a Text Only file into the Librarian.
**Mount Optical** Mounts an optical volume.
**Import New Volumes** Imports a volume that is not currently listed by the Index button.
**Update** Updates the current optical volume.
**Update All Volumes** Updates all optical volumes.
**Audition** Plays the selected event.
**Audition on Select** Plays the current event when it is selected.
**Place** -P Places the current cue in the sequence.
**Transfer to DTD**
**Transfer to Poly** Makes the current sound active on the keyboard.
**Quit** -Q Quits TransferMation.

Edit Menu

**Undo** -Z Reverses the most recent edit.
**Cut** -X Removes the selection and places it on the Clipboard.
**Copy** -C Places a copy of the selection onto the Clipboard.
**Paste** -V Places the Clipboard contents into the selection.
**Clear** -B Clears the field.
**Select All** -A Select all elements in the field.

Window Menu

**EditView** Opens EditView.
**MIDInet** Opens MIDInet.
**Autoconform** Opens Autoconform.
**TransferMation** Opens TransferMation.
**NED StartUp** Opens NED StartUp.
**Transport** Opens TransferMation Transport.
Librarian  Opens TransferMation Librarian.
Patch Bay  Opens TransferMation Patch Bay.
Info  Opens Info window.
Help  Opens TransferMation Help window.

### Display Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Seconds</td>
<td>Time fields are displayed in seconds.</td>
</tr>
<tr>
<td>Beats</td>
<td>Time fields are displayed in beats.</td>
</tr>
<tr>
<td>Measures:Beats</td>
<td>Time fields are displayed in measures:beats.</td>
</tr>
<tr>
<td>SMPTE</td>
<td>Time fields are displayed in SMPTE.</td>
</tr>
<tr>
<td>Feet:Frames</td>
<td>Time fields are displayed in feet and frames.</td>
</tr>
<tr>
<td>Minutes:Seconds</td>
<td>Time fields are displayed in minutes and seconds.</td>
</tr>
<tr>
<td>SMPTE Mode</td>
<td>Select the SMPTE mode: Drop Frame, Non Drop, 25 fps, 24 fps, NTSC 30.</td>
</tr>
<tr>
<td>Feet Mode</td>
<td>Select the Feet:Frames mode: 35mm and 30, 25 or 24 fps; 16mm and 30, 25 or 24 fps.</td>
</tr>
</tbody>
</table>

### Settings Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Mapper…</td>
<td>Displays the Key Mapper window for setting user-defined key equivalents.</td>
</tr>
<tr>
<td>Synchronization…</td>
<td>Displays a dialog for setting sequencer synchronization parameters.</td>
</tr>
<tr>
<td>Machine Control Prefs…</td>
<td>Displays a dialog for making protocol and serial port assignments.</td>
</tr>
<tr>
<td>External Sync</td>
<td>Turn on/off external synchronization.</td>
</tr>
<tr>
<td>Machine Control</td>
<td>Turn on/off synchronization and machine control.</td>
</tr>
</tbody>
</table>
EditView Menus

The following is an explanation of the menu commands that are available when EditView is active.

File Menu

- **New** -N Opens a new EditView window.
- **Open** -O not available
- **Close** -W Closes the EditView window.
- **Close EditView** Closes the EditView application.
- **Quit** -Q Quits the EditView application.

Edit Menu

- **Undo** -Z Reverses most recent edit of an event or time field.
- **Cut** -X Removes an event or region without changing the sync of the following events. Cut material is copied to the clipboard.
- **Copy** -C Places a copy of an event or time field onto the clipboard.
- **Paste** -V Merges the clipboard event onto a track beginning at the In point. Sync is unchanged. Or replaces a numeric field.
- **Split** -B Breaks an events in two at the In point.
- **Delete Time** -D Removes a region from the track to the clipboard. The sync of the following events is changed.
- **Insert** -I Adds the clipboard into the track at the In point, changing the sync of the following events.
- **Insert Leader** Adds leader into a selected region.
- **Fill** -F Pours the clipboard into a region, deleting any previous events.
  If the clipboard length is longer than the region, as much of the region as possible is filled. If the clipboard length is shorter than the region, a dialog presents the options loops fill or fill as much as possible. Sync is unchanged.
- **Fill with Leader** Pours leader into a region. Deletes overlapping events. Sync is unchanged.
- **Extract** -E Deletes everything on a track except what is between the In and out point. Sync is unchanged.
- **Exchange** Swaps a region on a track with the clipboard. Sync changes.
- **Replace Cue** Saves a cue back to the Cue Directory.
Window Menu

- **EditView** Opens EditView.
- **MIDInet** Opens MIDInet.
- **Autoconform** Opens Autoconform.
- **TransferMation** Opens TransferMation.
- **NED StartUp** Opens NED StartUp.

Events Menu

- **Align to Current Time** Moves the entire event and aligns the selected handle to the current time. Event duration is not changed.
- **Align to In** -opt-A Moves the entire event and aligns the selected handle to the In point. Event duration is not changed.
- **Align to Mark** Moves the entire event and aligns the selected handle to the mark point. Event duration is not changed.
- **Trim to Current Time** Moves the selected handle to the current sequence time. The event duration may be changed. If the Event Start handle is trimmed, synchronization is not retained.
- **Trim to In** -opt-S Moves the selected handle to the current In point. The event duration may be changed. If the Event Start handle is trimmed, synchronization is not retained.
- **Trim to Mark** Moves the selected handle to the current Mark point. The event duration may be changed. If the Event Start handle is trimmed, synchronization is not retained.
- **Move Mark to In** Moves the mark point to the In point.
- **Move Mark to Handle** Moves the mark point to the selected handle.
- **Zoom In** [-] Show less time.
- **Zoom Out** [-] Show more time.

Controls Menu

- **Audition** F12 Audition the event or region.
- **Play From** F9 Play from selected handle or time field.
- **Play To** F11 Play to selected handle or time field.
- **Stop Playback** F10 Stop.
- **Locate to Mark** Set the current time to the mark point.
- **Locate to In** Set the current time to the In time.
Locate to Out
   Set the current time to the Out time.
Clear Solos
   Un solo all tracks.
Clear Mutes
   Un mute all tracks.
Page Display
   Display will scroll while sequence plays.
Lock Display
   Display will not scroll while sequence plays.
Show Notes
   Show / hide all note events.
Show Volume Envelopes
   Show / hide volume envelopes.
Show Event Captions
   Show / hide event caption.
Show Output Routings
   Displays a window changing left and right channel routings.
Machine Control Prefs...
   Set machine control parameters.
External Sync
   - T
   Turn on / off external synchronization.
Machine Control
   - Y
   Turn on / off machine control

**Times Menu**

Event Start   - 1
   Select Event Start handle.
Fade In       - 2
   Select Fade In handle.
Event Offset  - 3
   Select Offset handle.
Fade Out      - 4
   Select Fade Out handle
Event End     - 5
   Select Event End handle.
Take In       F5
   Take the current time to the In time field.
Take Out      F8
   Take the current time to the Out time field.
Take Mark     
   Take the current time to the Mark time field.
Lock to In    F6
   Lock cursor to In point for scrubbing.
Lock to Out   F7
   Lock cursor to Out point for scrubbing.
Lock to Mark  
   Lock cursor to Mark point for scrubbing.
Chapter 2
Tutorial for the PostPro
**Projects**

The PostPro is an 8- or 16-track Direct-To-Disk system for recording and editing. A **project** is an area you designate on the hard disks that contains all of the material you record for one job. Before you can record, you must either open or create a project.

**Opening a Project**

To open an existing project—

1. Make TransferMation the active application by selecting **TransferMation** from the Window menu.

2. Select the **Librarian** from the Window menu.

3. Press the Index button in the upper left corner of the Librarian and select “Direct-to-Disk.” This displays the names of all projects on the DTD.

4. Double-click the project name that you want to open. The project name that you open becomes the current project. All new recording is added to this project.
Creating a Project

To create a new project—

1. Make NED StartUp the current window.

2. Make sure you are at the Main Menu. If you are on another display, press the Enter key to return to the Main Menu.

3. Select the Project Directory from the list of displays.
   This is one of the places where you can define a project. All project parameters are entered here.

<table>
<thead>
<tr>
<th>Project Title</th>
<th>Start</th>
<th>End</th>
<th>Rate</th>
<th>Avail</th>
<th>Used</th>
<th>Status</th>
<th>Mod</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Indy Demo</td>
<td>:00</td>
<td>1:09</td>
<td>50.0</td>
<td>1:09</td>
<td>1:09</td>
<td>Locked</td>
<td>Yes</td>
</tr>
<tr>
<td>Burger King</td>
<td>1:09</td>
<td>2:10</td>
<td>50.0</td>
<td>1:10</td>
<td>1:01</td>
<td>Unlocked</td>
<td>No</td>
</tr>
</tbody>
</table>

4. Type the name of your project under **Project Title** and press Return.

5. Type the start time of the project under **Start**. This defines the time on all the tracks at which a project begins, normally at the beginning of the track or just after the end of the previous project. Projects cannot overlap.

6. Type the end time of the project under **End**. This defines the time on all tracks at which the project ends, normally just before the start of the following project, or at the end of the disk. The end time can be changed before or after recording.

7. Type the sampling rate under **Rate**. This can be any number between 1 and 100 kHz. 50 kHz is the default.

Three parameters are kept up to date automatically by the system—

- **Avail** indicates how much time is available in the project.
- **Used** indicates how much time has been recorded in the project.
- **Mod** indicates if any changes have taken place to the project since the previous time you opened it.

**Status** is used to lock and unlock your project for protection. It toggles back and forth when you click and hold the trackball cursor over the word and press the Spacebar.


**Recording**

When you record to the DTD, the signal you record is generally saved as a cue.

**Setting the Record Parameters**

The first step in recording is to enter the track recording parameters. Repeat the following steps for each track on which you want to record.

1. Click on any TransferMation window to activate the application.
2. Select **Patch Bay** from the Window menu.
3. Type a track name under **Title** for the DTD track on which you want to record.
4. Click and hold the **Input** entry for that track and select “A-D 1A.” (This is the first input on the STM module in your control unit.)
5. Click and hold the **Mode** entry for the same track and select **Cue Playback**. This is the cue recording and playback mode.
Cue Recording

The most common way to record on the DTD is to create cues. A cue is a designated area on the hard disks where audio is recorded. A cue acts as a sort of audio clip that can be arranged in time with other clips to make a sequence or EDL. All recording is done from the Transport window. The Transport window is always open when TransferMation is active.

To record a cue—

1. Click and hold the Record button and select Allocate recording. This sets you up to create a new cue each time you record.

2. Click and hold the Record button again and select Manual trigger. The trigger determines when recording starts and stops. Manual indicates that pressing the Record button is going to determine the record Out times.)

3. Type a name and/or caption into the Cue and Capt fields. This is the name of the cue you are about to record.

4. Ready a DTD track by clicking a track number. After you ready a track, the field labeled “Available” calculates how much time is available on the selected track for recording.

5. Click Play and then Record to start recording.
6. Click **Stop** or **Record** to stop recording. A cue is named and saved in the Librarian.

7. Repeat the previous steps, but before recording, select Auto Place from the Record button. The cue will then be placed into EditView as an event. The name of the next cue automatically defaults to the cue name plus 1. If you want a different name, enter it before you record.

   • Press the **Retake** button after recording if you want to erase the cue you just recorded.
   • Press the **Block** button during recording each time you want to make a new cue. Cues are named automatically.
   • Press the **Undo Place** button if, after recording, you want to remove the cue from the sequence. This does not erase the cue, it merely removes it from the sequence.

**Cue Punch** is the other record mode. It is used to record over an event that has been selected in EditView.
Editing Cues

All recorded cues appear in the Librarian, which is a directory for all your sounds.

Viewing Cues

To view the sounds recorded in a particular project—

- As explained above, after you select the DTD from the Index button, a list of projects on the DTD appears on the left under the Index button and a list of all cues recorded on the DTD appears on the right. Double-click the project name. Your project cues are now listed on the right. Audition a cue by selecting its name and pressing F12.

You can search the displayed list of sounds for particular characteristics by typing text into the Find field and pressing Return. A space between words means and. A comma between words means or.

The sounds that are found as a result of a search appear in a list above the Find field.

If you search again, you will be searching this group of sounds, not the entire volume. To list all sounds on the volume again, click the name of the volume under the Index button.
Trimming a Cue

Editing a cue that is not in a sequence is done from the Audio Event Editor.

To edit a cue—

1. Before going to the Main Menu, select the cue you want to edit from the Librarian window. This makes it the current cue in the RTP as well.
2. Open the Audio Event Editor from the Main Menu.
3. At the top of the window are buttons used to display the panels that are part of the Audio Event Editor. Click CUE EDIT to display the Cue Editor.

<table>
<thead>
<tr>
<th>PROJECTS</th>
<th>CUE EDIT</th>
<th>CUE TRIM</th>
<th>CUE DIR</th>
<th>MOTION</th>
<th>EVENTS</th>
<th>RECORD</th>
<th>SWHC</th>
</tr>
</thead>
<tbody>
<tr>
<td>CUE STOR</td>
<td>OPT XFER</td>
<td></td>
<td></td>
<td>0J</td>
<td>USER 2</td>
<td>HH</td>
<td>HH</td>
</tr>
</tbody>
</table>

4. The Cue Editor has extensive cue editing features, but it is very useful for simply trimming excess audio off the head and tail of a cue.

The shuttle bar displays a representation of the selected cue. The In and Out points indicate the start and end of the cue’s recorded audio on the disk. When you drag the In or Out point with the trackball, audio is trimmed from the cue. This does not alter audio on the disk. The cue’s pointers merely point to a different location. You can always drag the point out again to include the original audio.

   As you drag the In or Out point, the cue scrubs the audio from that location. Scrub anywhere on the shuttle bar by dragging the cursor across any part of the white area of the bar.

You can also scrub in the two bars below the shuttle bar. The top bar represents the signal on the shuttle bar. It is the scan bar. When you drag the box inside the scan bar, the cue plays from the box as you drag.

The bar below the scan bar is the scrub bar. The scrub bar is used for fine scrubbing of the scan bar box location.

continued next page
5. To play a cue on the shuttle bar, click between the In and Out points, or click the In play button ▶️ In.

6. You can also trim a cue using the In and Out take buttons in the lower right corner of the Cue Editor. (If the Out buttons says “Dur” click and hold Dur and move the trackball until you display “Out.”)

To trim using the take buttons, play the cue and click the In take button where you want to start the cue and click the Out take button where you want to end the cue. The In and Out icons move to the new times.

7. If you want to view the cue as a waveform, click the SHOW WAVE button next to the scan and scrub bars. (This can take a few seconds.)

Other Editing Features

You can also edit a specific area of audio within the cue. Extraneous words can be removed, a word from one cue can be inserted into another, or audio can be slid or filled with leader, all without destroying the original audio. These kinds of edits are performed using edit points, which are placed using the scissors icons at either end of the shuttle bar.

To place an edit point—

1. Drag the left scissors to a point between the In and Out icons on the shuttle bar. This is where you want your edit to start. Drag the right scissors to the point between the In and Out icons where you want your edit to end.

2. You can also set an edit point using the Edit and Out take buttons in the lower right corner of the Cue Editor. (If the Out buttons says “Len” click and hold Len and move the trackball until you display “Out.”)

To set edit points using the take buttons, play the cue and click the Edit take button where you want set the start of the edit and click the Out take button where you want to set the end of the edit. The scissors icons move to the new times.

3. To play an edit, click between the edit points, or click the Edit play button ▶️ Edit.
There are many different types of non-destructive editing that can be performed on a cue using the edit points. For example, Cut removes the defined edit area from the cue. The command buttons below the shuttle bar are used to perform specific edit operations on the cue on the shuttle bar. Click a command to activate it.

<table>
<thead>
<tr>
<th>CUE</th>
<th>CLIP 1</th>
<th>CLIP 2</th>
<th>CLIP 3</th>
<th>CLIP 4</th>
<th>CLIP 5</th>
<th>CLIP 6</th>
<th>CLIP 7</th>
<th>CLIP 8</th>
<th>CLIP 9</th>
</tr>
</thead>
<tbody>
<tr>
<td>REEL</td>
<td>REEL A</td>
<td>REEL B</td>
<td>REEL C</td>
<td>REEL D</td>
<td>REEL E</td>
<td>REEL F</td>
<td>REEL G</td>
<td>REEL H</td>
<td></td>
</tr>
</tbody>
</table>

Many of these commands use the CUE, CLIP and REEL buttons, which act as temporary storage buttons. CLIPs and REELS are a type of clipboard for storing cues, or parts of cues. Activating a command often results in a dialog that asks if you want to select a CLIP or a REEL button. To do this just click on the button. There is no difference between a CLIP and a REEL, except that CLIP1 is the default clipboard. For example, if you cut audio from a cue, it is temporarily stored in CLIP1, just like the Macintosh clipboard.

While you are editing, a copy of the cue on the shuttle bar is stored in the CUE button. When you click the CUE button, (or CLIP or REEL) its contents appear on the shuttle bar.
**Sequencing**

A sequence is a synchronized list of audio events arranged in time.

---

**EditView**

You view the sequence from EditView. If EditView is not already open, select it from the Window menu.

The EditView tracks display graphically represents cues and RAM events (notes and sound files) which can be edited and moved in the sequence. EditView’s graphic interface displays the sequence by **output tracks**. Cues that are placed in EditView are called **audio events**.

The left portion of the EditView window consists of a Track List. The name and number of each track, as well as the solo and mute buttons, appear here. The currently selected track is highlighted red. To change the selected track, click on the track number, or click in the track area where no event is located.
Placing cues

TranferMation allows you to place cues from the Librarian into the sequence in a variety of ways. A Place button on the Librarian window allows you to set the type of place you want to perform: Paste or Insert. The audio event can then be placed into the sequence at the Current time, the EditView In, Out or Mark time, or the cue Sync time (set from the Audio Event Editor).

To perform a simple place—

1. Select DTD from the Index button on the Librarian.

   Projects appear on the left and all cues on all projects appear on the right.

2. If you want to look at only the cues from a specific project, select that project from the left.

3. Select a cue from the sounds list.

4. Select Paste from the Place button.

5. Select Current from the Place button.

6. Enter the number of the track on which you want to place the cue into the SEQ TRK.

7. Locate the sequencer to the time at which you want to place the cue’s In point.

8. Click the button, or press -P.

   The cue is placed in the sequence at the current time and appears on the EditView tracks display.
Selecting and Editing Events

Cues placed in a sequence are called events. Events are a window on the source audio. They can be edited and moved in the sequence. To edit an event you must first select it in EditView.

To select an event—

1. Click from the tools list.
2. Click on an event.
   
   The name of the event and its caption appear at the top of the display.

When a cue event is selected, five handles appear as small boxes at the Event Start, Event End, Fade In, Fade Out, and Offset times. When a note event is selected, Event Start and Event End handles appear. Dragging a handle to a different time is one way to edit the event.

![Event Handles Diagram]

To move a handle—

- Click a handle and drag it.
   
   The handle moves with the cursor.

You can also use the Events menu trim commands to move a handle—

1. Select an event.
2. Locate to the time at which you want to trim the Event Start.
3. Select Trim to Current Time from the Events menu.
   
   The Event Start handle moves to the current time.

Times relevant to the selected handle appear at the top of the window, along with the event name and caption. The time associated with the currently selected handle is highlighted. Any handle can be moved by selecting its time field and editing it. The result of the edit is graphically displayed in EditView.
To move an event —

1. Select the tool.
2. Click and drag the entire event.
   or
   Use the arrow keys to move the event up and down or left and right.

---

**Region Editing**

When an event is not selected, you can do region editing. During region editing, event handles are ignored, and you are not restricted to editing discrete events—any region on the track can be edited. Editing a region, however, can affect multiple events and the synchronization of the entire track.

Edit In and Edit Out points define a region on a single track for editing. When a region is defined, the entire track area between the In and Out points is selected, regardless of the start and end times of events. These marks appear on the ruler and in the time fields.

![Region Editing Controls](image)

To set In and Out points—

1. Drag the In icon on the ruler to the beginning of the edit.
   Once an edit time has been selected, the trackball is locked to it for scrubbing.
2. Drag the Out icon on the ruler to the end of the edit.
3. Click in any open area at the top of the window or press the Enter key to deselect the edit time.

You can use one of the EditView Edit menu commands to edit the region.

To perform a region cut—

1. Click the number of the track you want to edit.
2. Make sure the In and Out points are set (see above).
3. Select Cut from the Edit menu.
   The edit region is removed from the track.
Tracks and Projects

The DTD hard disks are partitioned into tracks and projects.

DTD Tracks

The DTD contains hard disks that are used for recording and playback. Any sound recorded to the DTD is recorded onto these hard disks, which are partitioned into tracks. The number of tracks available depends on the number and configuration of the hard disks installed. In a normal configuration, each hard disk has two tracks, each track having one hour of recording time.

To double the number of tracks available and consequently cut the amount of recording time per track to 30 minutes, you must reconfigure for four tracks per drive. In this configuration, sampling rates are limited to 50kHz or less. In order to take advantage of this configuration you must purchase the MaxTrax option. An upgraded meter bridge is also required.

MaxTrax only works on systems with four or fewer drives (SCSI ports). The drives must be Wren IV or later.

To increase the recording time per track to two hours you must reconfigure for one track per drive. As a consequence, the recording time on all odd-numbered tracks is doubled while the recording time on all even-numbered tracks becomes unavailable.

All audio in all projects is erased when you reconfigure for a longer or shorter tracks. Make sure all projects are backed up to tape before beginning this procedure.

Reconfiguring tracks is done from the Project Directory. Select the Erase All command and then type one of the following commands:

- **erase** Erase all tracks but leave the configuration unchanged.
- **erase 1** Erase all tracks and reconfigure for one track per drive. (Long configuration)
- **erase 2** Erase all tracks and reconfigure for two tracks per drive. (Normal configuration)
- **erase 4** Erase all tracks and reconfigure for four tracks per drive. (MaxTrax configuration)

In any of these track configurations, the hard disks are partitioned differently to accommodate your needs. To find out the number of tracks and the amount of recording time available to your system, check Tracks Available (number of tracks that can be recorded simultaneously) and Total Recording Time (based on 50 kHz) at the top of the Project Directory in the RTP.
What Is a Project?

Projects are one of the cornerstones of the DTD. A project contains all of the recorded material—music, dialog, sound effects, Foley—for one job. Before any recording can take place, you must create a project area on the DTD, which defines where on the disks your recorded material is located. A project reserves the same time on all tracks. For instance, in a normal 8-track configuration, reserving the first three minutes for Project 1 reserves the area 0:00-3:00 on DTD tracks 1-8.

A project can comprise the total track time available, or just a few minutes. In this way you can have more than one project on your DTD. However, projects cannot overlap. When you record to the end of a project, recording stops. This protects you from accidentally recording over other projects.

You can work in only one project at a time, but cues from other projects are available. The project you are working in is called the current project. All recording is done within the current project. You cannot be in one project and record to another.

Opening a Project

There are several places from which you can do project management, primarily TransferMation and the Project Directory (O page).

To open a project—

1. Select TransferMation from the Window menu.
2. Select Librarian from the Window menu.
3. Select Direct-to-Disk from the Index button.

The names of all projects on the DTD are display on the left and the names of all cues on all projects are displayed on the right.
4. Double-click the name of the project that you want to open.

A red diamond appears next to the open project. The cues in that project are listed on the right. All new recording is added to this project.

Single-clicking a project name displays the cues on that project, but it does not change the current project. You must double-click to change projects.

Creating a Project

To create a new project—

1. Select the Project Directory from the RTP.

   Existing projects are listed under Project Title.

2. Enter the four project parameters listed below into an empty project. (An empty project has a Start and End time of 0:00.)

   **Project Title**  The name of the new project should be specific enough to clearly identify your project, without exceeding 24 characters. This name can be changed.

   **Start**  The start time defines the time on all tracks at which a project begins, normally at the beginning of the tracks or just after the end of the previous project. Projects cannot overlap. The start time can be changed before recording, but it cannot be changed after recording. Start time is shown as Minutes : Seconds, based on a 50 kHz sampling rate.

   **End**  The end time defines the time on all tracks at which the project ends, normally just before the start of the following project, or at the end of the disk. The end time can be changed before or after recording, but it cannot be less than the time at which you stopped recording. End time is shown as Minutes : Seconds, based on a 50 kHz sampling rate.

   **Rate**  The sampling rate for recording and playing back is the same for all tracks in the project. It can be set to any number from 1–100 kHz; 50 kHz is the default. The sampling rate should be set before recording. When you change the sampling rate, the available recording time automatically changes to reflect the new rate. The start and end times of the project on the disk, however, do not change automatically. If you change the sampling rate after recording, playback will be changed.
The parameters **Avail** and **Used** indicate the amount of time available for recording on the hard disks and the amount of time used by the longest recorded track. **Mod** indicates if the project has been modified by recording, or loading from tape. All three parameters are set automatically.
**Status** indicates if your project is locked (protected) or not. A “Locked” project is protected from accidental erasure. You cannot record, erase tracks, erase the project or load a project in that location, but you can play back. An “Unlocked” project can be recorded into. To change the lock status, select the **Lock** or **Unlock** command at the bottom of the Project Directory. (You can only lock a project that has recorded material on it. A track with no recorded material on it is **Empty**.)

At the top of the display, **Tracks Available** indicates the number of tracks that can be recorded simultaneously. This number is based on the number of hard disks installed in your system and the current configuration. **Total Recording Time** indicates the total amount of recording time available in the project. When you partition your hard disks into more than one project, recording time within the project always begins at 0:00.

The amount of time shown initially on the display is based on a 50 kHz sampling rate. If you select a sampling rate other than 50 kHz, you must calculate the actual adjusted time. For instance, 5 minutes recorded at 50 kHz equals 2.5 minutes at 100 kHz or 10 minutes recorded at 25 kHz.

You can open a project from the Project Directory by selecting the name and pressing Return.

### Deleting a Project

Deleting a project erases all recorded material in the project. You may want to do this to make room for another project.

Make sure your project is backed up before you delete.

Use the Project Directory to delete a project.

- To delete a single project, select the project by clicking on the name and then select the **Erase Proj** command. Type `erase` and press return.
- To erase all projects on the DTD, select the **Erase All** command and type one of the erase commands mentioned above under “DTD Tracks.” (The names of the projects are not erased until you do it manually.)
Basic Recording

There are several different types of recording that you can perform. Basic recording takes place from TransferMation.

Track Parameters

To set up for recording, display the Patch Bay window. Each DTD track in your current project is listed. There are three track parameters that must be set for each track in order to record: Title, Input and Mode.

Type a track Title next to each track you plan to use. The name should be specific enough to clearly identify your track, without exceeding 16 characters. You can change the title at any time. (You do not have to enter a track title in order to record, but to avoid confusion, it’s a good idea.)

The track select button to the left of the name is used to Ready the track. Click it to ready a track. The button turns red when a track is readied. The corresponding track button on the Transport also lights.

The Input column is used to assign an input source and channel to each track. (You can assign a single input to more than one track, but only one of these tracks can be recorded at a time.) The A-D input is a signal derived from sampled live audio via the analog-to-digital converter of the STM module. It uses channels 1A-4D. Click and hold the input setting (e.g., A-D 1A) and select from its pulldown menu. ("A-D" appears as "STM" in other Synclavier Company applications.)
The **Mode** column is used to assign a record/playback mode for each track. Click and hold the mode setting and select from its pulldown menu. Selections are as follows:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input</strong></td>
<td>Record mode. Hear the signal entering through the assigned input. If you play back in this mode, you cannot hear what is on the track.</td>
</tr>
<tr>
<td><strong>Auto</strong></td>
<td>The track is in Cue Playback during playback and Input during record and while stopped.</td>
</tr>
<tr>
<td><strong>Cue Playback</strong></td>
<td>Playback mode for cues. During recording the track is in Input. During playback, you only hear triggered cues. This is the playback mode for cues placed in a sequence.</td>
</tr>
<tr>
<td><strong>All Input</strong></td>
<td>All tracks are set to Input mode.</td>
</tr>
<tr>
<td><strong>All Auto</strong></td>
<td>All tracks are set to Auto mode.</td>
</tr>
<tr>
<td><strong>All Cue Playback</strong></td>
<td>All tracks are set to Cue Playback mode.</td>
</tr>
</tbody>
</table>

---

**Cue Recording**

During **cue recording** the incoming signal is digitized and saved on the DTD hard disks as cues. A **cue** is a piece of audio which can be played, edited and assembled into an EDL without changing the original recording. A cue points to audio on the disk and recalls it instantly using Synclavier Digital’s random access technology. All editing of cues is nondestructive and playback is instantaneous.

All recording is done from the Transport window using the Record button to set the type of recording that you want to do.
The Record button displays a list of recording parameters.

**Manual** Trigger mode: Start and stop recording by pressing the Record and Stop motion control buttons.

**Auto** Trigger mode: Recording occurs automatically at the In and Out points in EditView.

**Allocate** Record mode: The default mode. Each time you start and stop recording, a cue is created and stored in the Librarian.

**Cue Punch** Record mode: Record over a previously recorded cue that has been placed in EditView as an event.

**Auto Place** The recorded cue is automatically placed onto the selected EditView track at its sync time (In time).

**Auto Select** When you ready a track, the DTD track as well as the same number output in EditView are automatically selected.

**All Safe** You are not able to record on any tracks.

To manually record a cue—
1. Select the **Allocate** command from the Record button on the Transport.
2. Select the **Manual** trigger from the Record button.
3. Ready a DTD track by clicking a track button. (You can also click the track button in the Patch Bay.)
   - The **Available Time** field shows how much time is remaining on the selected DTD track.
4. Click Record to start recording and Stop to stop recording.

Use **Auto** trigger instead of **Manual** trigger if you want to trigger recording automatically using EditView’s In (start recording) and Out (stop recording) points. (See the chapter “Editing” for instructions on setting In and Out points.)

To automatically record a cue—
1. Select the **Allocate** command from the Record button on the Transport.
2. Select the **Auto** trigger from the Record button.
3. Ready a DTD track by clicking a track button. (You can also click the track button in the Patch Bay.)
4. Set In and Out points in EditView. (See the chapter “Editing” for instructions.)
5. Locate to a time before the In point.
6. Click Play and then Record
   - Recording automatically begins at the In point and stops at the Out point.
7. Click Stop to stop playback.
Click the **Retake** button after recording if you want to erase the previous take (and remove it from the sequence, if you auto-placed). After the retake, the DTD is ready to record again from the previous location. To retake any other cue, select it in EditView or double-click it in the Librarian before clicking Retake.

Click the **Block** button during recording if you want to make more than one cue out of a recording; a new cue is created each time the button is clicked. The current cue name is incremented with each new cue.

Select the **All Safe** command from the Record button menu to unread all DTD tracks.

The **Available Time** field shows the total time remaining on the selected DTD track. (See “Cue Punch” below for an exception.)

The cue name appears in the **Cue** field. If you want a different name, type it in before you record. You cannot use the same name twice, although you can increment a name (e.g., Take 01, Take 02). This will be done automatically if you do not change the cue name between recordings. A cue can also contain a caption by typing it into the **Capt** field. A caption is used for further identification of the cue.
Auto Functions

Place a cue automatically into the sequence after recording using the auto commands in the Record button on the Transport panel.

- When Auto Place is selected during recording (and the sequencer is in play), the cue is automatically placed onto the selected EditView track at its sync time (In time). When recording stops, the cue is automatically placed on the sequence track selected in EditView and it appears in the Librarian. If Auto Place is not selected during recording, the cue is only recorded to the DTD.

- If Auto Select is selected when you ready a track, the DTD track and the same number output in EditView are automatically selected.

You can also remove a cue that you have just placed—

- Click the Transport Undo Place button if you want to remove the event from the sequence. This does not erase the cue from the Librarian.

Cue Punch Recording

Cue Punch recording allows you to record over a previously recorded cue that has been placed in EditView as an event. While Allocate mode creates new cues, Cue Punch mode records over old ones.

Cue Punch recording is destructive. Audio on the DTD is replaced. All events in the sequence referencing the edited cue are changed.

Using the Cue Punch mode is very similar to using the Allocate mode. The Manual and Auto triggers work the same. One difference is that when using Cue Punch, you must select an event in EditView first before recording. This is the event that you are going to punch over.

To record over a cue manually—
1. Select the event in EditView that you want to record over.
2. In the Transport, select Cue Punch mode from the Record button.
3. Select Manual trigger from the Record button.
   The Available Time field on the Transport shows the duration of the cue. If it is the last cue on the DTD track, it shows the time remaining on the DTD track.
4. Click Record to start recording. Recording will stop automatically at the end of the cue. All events referencing the cue are changed.

Once recording has ended, the Cue Punch mode automatically reverts to Allocate. This is a safety feature that protects you from inadvertently destroying audio.

If the cue is the last cue on the track, click the Stop button to stop recording. Otherwise, recording continues past the end of the cue.
You can also punch over only a portion of a cue. This can be done while the sequencer is running using either Auto or Manual mode.

To punch over a cue automatically—

1. Select the event in EditView that you want to record over.
2. Set In and Out points to indicate the start and stop record times.
3. In the Transport, select **Cue Punch** mode from the Record button.
4. Select **Manual** trigger from the Record button.
   
   The **Available Time** field on the Transport shows the duration of the cue. If it is the last cue on the DTD track, it shows the time remaining on the DTD track.

5. Locate to before the In time.

6. Click the Play button and then Record when you want to start the sequencer. Recording takes place between the In and Out points.

When recording stops, the cue is saved on the DTD. All events referencing the cue are changed. The Cue Punch mode automatically reverts to Allocate after recording. This is a safety feature that protects you from inadvertently destroying audio.

In Cue Punch mode, if you change the ready state of a track, the mode automatically changes to Allocate. This is a safety feature that protects you from inadvertently destroying audio.

---

**Mark Points**

A mark point is a reference time in the sequence that you can locate to. Up to 20 mark points can be defined by the user.

The current mark point time appears below the Transport current time. Each mark point has an assigned number and label. Display a list of mark points by pulling down the mark point button. The mark you select becomes the current mark point.

The mark point button contains a list of commands. Create a new mark by selecting **New** and entering a mark point time. You can also take the current time into the mark point field by placing your cursor there and pressing **F13**.
Display the label instead of the time by selecting **Show Label** from the mark point button. Assign a label to the current mark by selecting **Label...** (A maximum of 20 mark points are allowed.)

Autolocate the sequencer to the current mark by clicking the locate button that appears as a large “L” to the right of the mark point time display. Pressing a keypad number twice with the Control key locates and also plays from that mark point.

When the EditView mark is moved, the mark points in TransferMation and the Audio Event Editor remain unchanged.

There are several ways to display, locate and/or play using mark points—
- Click the Locate button to autolocate the sequence to the current mark.
- Press the up arrow key twice while pressing the Control key to locate and play from the current mark.
- Press Option and a keypad number [1-9] to display a numbered mark point.
- Press Control and a keypad number [1-9] to locate to a numbered mark point. If you press the keypad number twice you will locate and play from the mark point.

To create a mark point—
1. Click and hold the mark point button on the Transport.
2. Select New from the menu.
   The next available mark point number is displayed on the button.
3. Enter a time into the mark point time field, or press F13 to take the current time.
4. Add a text label to the current mark point by pulling down the mark point menu again and selected Label...
   Enter text, which will be saved with the current mark point.

To recall a mark point—
1. Click and hold the mark point button on the Transport.
2. Select the desired mark point from the menu.
   The time associated with the selected mark point is displayed.
3. If you want to locate the sequencer to this time, click the locate button.
Advanced Recording Features

The recording functions described below are performed from TransferMation or the Audio Event Editor.

Optical Transfer

You can record a sound file from an optical disk into the current project on the DTD. The sound file becomes a cue and its sample rate is converted to the sample rate of the project.

The sound file will be converted to the project sample rate only if you have a DSP70 board installed in your DTD computer.

Make sure that your optical disk is inserted into the drive and mounted. (A mounted optical appears in the Index menu with a headphone icon next to it.) Transferring an optical sound to the DTD is performed from the Librarian.

1. Select the optical volume from the Librarian Index button and select the sound file you want to transfer to the DTD.

2. Select the **Transfer to DTD** command from the File menu. The following record dialog appears, which is used to record the optical sound to the DTD.

3. Type a new Cue Name, if desired.

4. The first available DTD track is selected for recording. (If a stereo sound was selected, two tracks appear.) Click and hold the DTD TRKS button to select a new track number. If a track number is grayed out, there is not sufficient room on the track to record the selected sound.

5. Click the Record button to start recording the sound file to the DTD. The sound is recorded to the DTD as a cue. The Cancel button halts recording; no information is transferred. Once recording stops, the cue appears in the Librarian.

To retake the cue, click the **Retake** button on the Transport. This erases the cue and prepares the DTD to record another cue in the same location.
Poly Transfer

If you have polyphonic sampling voices, you can make the currently selected cue the current timbre on the keyboard by selecting the command Transfer to Poly from the TransferMation File menu. The sound can now be auditioned by pressing A3 on the Synclavier keyboard.

You can also record the current sound file in poly memory onto the DTD. To do this, you must go to the Audio Event Editor and open the Record panel (RECORD).

1. Select the Allocate mode and PolyXfer trigger.
2. Arm a track.
3. Click READY and then RECORD.
4. When a dialog appears, click [TRANSFER].

The sound in poly is transferred and saved on the DTD.

If you choose to record the above in Cue Lock mode instead of Allocate, you can record over a specific cue on the DTD. (This is similar to Cue Punch mode in TransferMation.) Before recording, select the cue you want to record over. (This can be done from the Librarian or the Audio Event Editor’s Cue Directory panel.) When you begin recording, a dialog appears from which you have to choose one of the selections described immediately below. Click TRANSFER after you have made your selection.

- **COMPUTE TO END** If the sound file is shorter than the cue, trim the cue length to the length of the sound file. (If the sound file is longer than the cue and the cue is sandwiched between two other cues, the cue cannot be made longer. If it is the last cue on the track and there is time available, the entire cue will be transferred.)
- **FILL TO END** If the sound file is shorter than the cue, transfer the sound file and then fill the remaining space with silence.
- **EXTRACT** If the sound file is longer than the cue, only as much of the sound file as will fill the cue is transferred.

To audition the new cue, open the project in the Librarian, select the cue and press F12.

Time Scale Modification

If you have purchased the Time Scale Modification (TSM) module, a DSP70 card has been installed in your DTD computer that allows you to compress or expand the duration of a cue without changing its pitch.

TSM is performed from the Record panel of the Audio Event Editor (Q page). Modify the time scale of a cue by selecting one of three settings for the switch labeled “Alg” on the Record panel.

- Use ONE for most speech or solo instruments or for cues containing percussion.
- Use TWO for most music or sound effects or for stereo cues with substantially different tracks.
- Use THREE for mixed music or stereo cues.
You can specify the desired length of the cue, or you can specify the ratio of compression or expansion. If you specify a length, the ratio value automatically changes to reflect the new length. If you specify a ratio, the length value automatically changes to reflect the new ratio.

It might take some experimentation to find the best algorithm and ratio for a particular type of audio signal.

When you modify the time scale of the current cue, it is internally re-recorded onto the DTD track you select. The original cue remains intact. Stereo cues are re-recorded as stereo cues, and mono as mono.

ONE

The length of the current cue is the default value shown in the field labeled “New cue length.” You can enter any other value between four-fifths and six-fifths the length of the current cue. The default ratio of compression or expansion is 1.0000. You can enter any other value between 0.8000 and 1.2000 in the field labeled “Ratio.” Click L to enter a cue length, or click R to enter a ratio.

ONE separates the cue into regular intervals, and cuts (for compression) or loops (for expansion) at least one segment of the cue within each interval. The value in the field labeled “Max cut” indicates in milliseconds the longest segment that can be cut or looped from each interval. You can enter any value between 5.12 and 40.96.

The value in the field labeled “Justification” indicates the relative size of the intervals. You can set the Justification value to 1, 2, 3 or 4. A value of 4 separates the cue into the longest possible intervals is appropriate for most cues, except those that are clearly rhythmic. We recommend that you first modify the time scale with the Justification set at 4, and listen to the result.

TWO and THREE

The length of the current cue is the default value shown in the field labeled “New cue length.” You can enter any other value between half and twice the length of the current cue. The default ratio is 1.0000. You can enter any other value between 0.5001 and 1.9999 in the field labeled “Ratio.”

To use TSM—

1. Select Allocate mode and TSM trigger from the Record panel.

The TSM dialog appears in the upper right corner of the panel.
2. Use the arrows to select a cue from the dialog.
3. Click L or R and enter a cue length or ratio.
4. Set the Alg switch and enter a cue length or ratio.
5. Select a destination track and a cue name, if desired.
6. Click READY and PROCESS. If you want to stop the TSM, press Spacebar and a cue of the portion processed to that point is saved.

**Bouncing DTD Tracks**

The bounce feature allows you to move audio from one DTD track to another, without altering the original recorded quality.

You can bounce up to two DTD tracks one at a time from one track to another. Bouncing tracks is most easily performed from the Track Display (P page) and Audio Event Editor (Q page). The bounce mechanism can be turned off and on, without having to reset the bounce routings. When bounce is turned off, the routings are just ignored.

To bounce DTD tracks—

1. Open the Track Display and click the BOUNCE button in the upper right corner of the display.

   ![Click to turn on bounce]

2. Decide which track you want to bounce (source track) and set the Status to Safe and the Mode to Repro.
3. Decide which track you want to bounce the source track to (destination track) and set its Status to Ready and its Mode to Input.
4. You must also set the Input parameters for the destination track. Toggle the source side of the Input parameter to TRK. This indicates the source of input is another DTD track. Now toggle the right side of the Input parameter to the number of the source track. This indicates that the destination track is getting input from the DTD track number you set.

   ![Input source of TRK 1 source track number]

   continued next page
5. Click RECORD when you want to start the bounce and STOP when you want to stop the bounce.

6. Click OFF to turn the digital bounce feature off.

If you initiate the bounce by pressing RECORD on the Track Display, the audio on the destination track does not contain cues. To make a cue of the entire track, see “Clear Edits” in the Index.

You can also trigger the bounce from the Record panel of the Audio Event Editor, where you can bounce the new track as a cue.

1. Set the Mode switch to Allocate and the Trig switch to Manual.
2. Click READY and RECORD to start the bounce.
   (If you use Sequencer trigger instead of Manual, recording does not begin until you start the sequencer. Stop the sequencer when you are done recording.)
3. Click STOP when you want to stop the bounce.

There is no delay recording to the track, but there is a delay hearing the output if you monitor the track output while bouncing.
Cue Bounce

You can copy a mono or stereo cue from one DTD track to another using the Record Control panel of the Audio Event Editor. The original cue remains unchanged. The new cue is renamed and recorded to another track. A stereo cue is rerecorded on two tracks.

1. Select the cue you want to bounce. This can be done from the Audio Event Editor, TransferMation or EditView.
2. Open the Audio Event Editor and select the Record Control panel.
3. Select the Allocate record mode.
4. Select the Bounce trigger. When Bounce is selected, the name of the current cue appears on the right next to a pair of scroll arrows. Another cue can be selected by clicking these arrows.
5. Ready a track for recording by clicking the track number to which you want the cue bounced. (Click any two track numbers for a stereo cue.) The READY button will blink to indicate a track is ready.
6. The name that will be given to the bounced cue is shown in the bottom left corner of the panel. You can change this name by selecting it and typing a new name.
7. Click RECORD. The following dialog appears:
   “BOUNCE cue to track(s): [REPLACE IN SEQUENCE] [BOUNCE] [CANCEL]”
8. If you want to bounce a cue to another DTD track without affecting the sequence, click [BOUNCE].
   or
   If you want to bounce a cue to another DTD track and also replace the cue in the sequence, click [REPLACE IN SEQUENCE] and then [BOUNCE].

In order to replace a cue in the sequence, you must first select the cue from the sequence (ie., EditView or AEE Event List Editor). See Step 1.
**Digital Transfer** If you have the Universal Digital I/O (UDIO) hardware installed, you can transfer digital audio between the DTD and another digital device without leaving the digital domain and while retaining the original recorded quality. Use ProDigi, SDIF, AES/EBU or S/PDIF format to transfer one or two tracks of audio at a time. Tracks can be routed to or from either of the two digital channels: DIG 1 (left) and DIG 2 (right).

For more information on UDIO, see the chapter “Hardware Specifications” in *Manual III*.

To prevent system slowdown, digital I/O should be off whenever you are not actually transferring digital information.

---

**Synchronization and Sampling Rate**

If you are using SMPTE with digital I/O, the system waits for an incoming SMPTE signal before beginning the transfer. When you are striping SMPTE onto tape, the tape machine and the time code generator must be locked to the same house sync signal.

When transferring digital audio, the sample rate of the DTD must be the same as the sample rate of the other digital device. If you are using either drop frame time code locked to color house sync (29.97 fps) or non–drop frame time code locked to black and white house sync (30 fps), set one of the following sample rates on the Project Manager panel of the Audio Event Editor.

<table>
<thead>
<tr>
<th>set this sample rate</th>
<th>to obtain this actual rate (kHz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>31.9*</td>
<td>31.9680*</td>
</tr>
<tr>
<td>32.0</td>
<td>32</td>
</tr>
<tr>
<td>44.0</td>
<td>44.0559</td>
</tr>
<tr>
<td>44.1</td>
<td>44.1</td>
</tr>
<tr>
<td>47.9*</td>
<td>47.9520*</td>
</tr>
<tr>
<td>48.0</td>
<td>48</td>
</tr>
<tr>
<td>88.1</td>
<td>88.1118</td>
</tr>
<tr>
<td>88.2</td>
<td>88.2</td>
</tr>
<tr>
<td>95.9*</td>
<td>95.9040*</td>
</tr>
<tr>
<td>96.0</td>
<td>96</td>
</tr>
</tbody>
</table>

* these rates are not available when transferring out from the DTD while locked to the internal sync source.
Non-Drop Time Code and Color House Sync

In some situations, you may be using non-drop frame time code locked to color house sync (29.97 fps). If so, you need to set one of the following special sample rates provided specifically for this case.

<table>
<thead>
<tr>
<th>set this special sample rate</th>
<th>to obtain this actual rate (kHz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>32.1</td>
<td>32</td>
</tr>
<tr>
<td>44.2</td>
<td>44.1</td>
</tr>
<tr>
<td>48.1</td>
<td>48</td>
</tr>
<tr>
<td>88.3</td>
<td>88.2</td>
</tr>
<tr>
<td>96.1</td>
<td>96</td>
</tr>
</tbody>
</table>

Monitoring Tracks

Although there is never a recording delay when transferring data, a delay can be heard in two instances when monitoring digital I/O.

- Digital input is routed directly to a Direct-to-Disk output.
- A track receiving input from an stm module is simultaneously routed to a digital output.

In these cases, there is a constant output delay of 75 milliseconds.

To avoid full-level noise in your speakers, keep the audio levels down until you are sure that the sync signal is locked and the sampling rate and digital format are correct.

Digital Transfer Settings

Before transferring data between the DTD and another digital device, you must set the digital format that corresponds to the other digital device. This is done by selecting the Digital Transfer button on the Audio Event Editor Selection panel. Set the Format switch to one of the following—

- ProDigi 2 Track
- SDIF 2 Track
- ProDigi Multi
- SDIF Multi
- AES/EBU
- S/PDIF

If you are transferring from the DTD to another digital device, you must also set the appropriate time base reference for clocking the outgoing sample. Select the clock signal source from the Output Sync switch—
### Output Sync Setting

<table>
<thead>
<tr>
<th>Setting</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal</td>
<td>Selects the DTD’s internal crystal as a time base reference.</td>
</tr>
<tr>
<td>External Default</td>
<td>Selects a clock signal that corresponds to the digital format being used (for example, selects an SDIF word clock signal for a transfer using the SDIF format).</td>
</tr>
<tr>
<td>NTSC B+W</td>
<td>Selects a 30 fps composite (house) sync signal as the time base reference.</td>
</tr>
<tr>
<td>NTSC Color</td>
<td>Selects a 29.97 fps composite (house) sync signal as the time base reference.</td>
</tr>
<tr>
<td>PAL/SECAM</td>
<td>Selects a 25 fps composite (house) sync signal as the time base reference.</td>
</tr>
<tr>
<td>Ext ProDigi 2 Track</td>
<td>Selects a ProDigi two-track word clock signal as the time base reference for a transfer using any of the digital formats.</td>
</tr>
<tr>
<td>Ext ProDigi Multi</td>
<td>Selects a ProDigi multitrack word clock signal as the time base reference for a transfer using any of the digital formats.</td>
</tr>
<tr>
<td>Ext SDIF</td>
<td>Selects an SDIF word clock signal as the time base reference for a transfer using any of the digital formats.</td>
</tr>
<tr>
<td>Ext AES/EBU or S/PDIF</td>
<td>Selects an AES/EBU or S/PDIF derived clock signal as the time base reference for a transfer using any of the digital formats.</td>
</tr>
</tbody>
</table>

If you set Output Sync to Internal, the time base reference is an internal clock signal. For any other sync source, you must connect the appropriate sync signal to the connector listed in the following table.

<table>
<thead>
<tr>
<th>Sync Source</th>
<th>Sync Signal Connector</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC or PAL/SECAM</td>
<td>COMPOSITE SYNC IN</td>
</tr>
<tr>
<td>ProDigi</td>
<td>PRODIGI Dub in</td>
</tr>
<tr>
<td>SDIF</td>
<td>SDIF2 WORD SYNC In</td>
</tr>
<tr>
<td>AES/EBU or S/PDIF</td>
<td>AES/EBU In</td>
</tr>
</tbody>
</table>
Digital Transfer Out

The following instructions presume that you have already set the sampling rate, selected the appropriate digital format and synchronization source, set up the digital tape recorder for recording and connected the sync signal.

To transfer a DTD track or a cuelist, display the Project Manager in the Show Project mode and the Audio Event Editor Motion Control panel.

1. On the Project Manager, set the Status for each track you want to transfer out to Safe.
2. To transfer a DTD track, set the Mode to Repro. To transfer a cuelist, set the Mode to CuePB.
3. Assign the DTD track or cuelist to the desired output.
4. For the assigned output number, enter 1 or 2 in the column labeled DTD. Audio from the selected output is routed to the specified digital I/O channel. Volume and pan settings have no effect on the digital signal.
5. On the Selection panel, click the Digital Transfer OUT button to turn on digital I/O. The AUDIO module requires two minutes to lock to house sync. If you are using house sync, wait until the module is locked to the sync signal.
7. On the Motion Control panel, click START to start playback on the DTD. The Direct-to-Disk tracks or the cuelists routed to the digital I/O channels are recorded on the digital tape recorder.
8. Click STOP to stop playback.
9. Stop the tape recorder to stop recording.
10. Click the Digital Transfer OFF button on the Selection panel to turn off digital I/O.

To transfer individual cues, display the Project Manager in the Show Project mode and the Cue Directory. When you transfer a cue, any information about cue synchronization and output routing is ignored.

1. On the Project Manager, select the project containing the cues to transfer.
2. On the Cue Directory panel, set the switch labeled Function to Recall & Play.
3. On the Selection panel, click the Digital Transfer OUT button to turn on digital I/O.
4. Start recording on the digital tape recorder.
5. On the Cue Directory panel, click the name of the cue to transfer it to the digital tape recorder.
6. Stop the tape recorder to stop recording.
7. Click the Digital Transfer OFF button on the Selection panel to turn off digital I/O.
Digital Transfer In

The following instructions presume that you have already set the sampling rate, selected
the appropriate digital format, set up the digital tape recorder for recording and
connected the sync signal.

To transfer digital audio from another digital recorder to the DTD, display the Project
Manager in the Show Project mode, the Motion Control panel and the Record panel.

1. On the Project Manager, set the following parameters for each destination track.

<table>
<thead>
<tr>
<th>Status</th>
<th>Mode</th>
<th>Input source</th>
<th>Input channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>READY</td>
<td>Input</td>
<td>DIG 1 or 2</td>
<td></td>
</tr>
</tbody>
</table>

2. Set the mode and trigger switches on the Record panel for the type of recording you
   want to do.

3. On the Selection panel, click the Digital Transfer IN button to turn on digital I/O.

4. If the trigger switch on the Record Control panel is set to Manual, click READY and
   RECORD on the Record panel. If the trigger switch is set to Sequencer, also click
   START on the Motion Control panel. Recording begins.

5. Start playing back the digital tape recorder to start digital transfer.

6. Stop the tape recorder to stop playback.

7. Click STOP on the Record panel to stop recording.

8. On the Selection panel, click the Digital Transfer OFF button to turn off digital I/O.
External Synchronization

TransferMation can sync to external machines.

Synchronization Preferences

Set the synchronization parameters for the sequencer by selecting Synchronization… from the Settings menu. If you sync to SMPTE, select Drop, Non Drop, 25 fps, 24 fps or NTSC 30 from the pulldown menu under SMPTE.

Machine Control

External synchronization and machine control can be controlled from the TransferMation Setting menu or from the EditView Controls menu.

When machine control is on, you can control external equipment. When you scrub to picture all of the locate functions operate to locate the external machine as well as the sequence. The serial port is opened when the Transport is the current window and released when another window is selected.

Each window has a machine control button which, when clicked, turns machine control on and off. You can also select Machine Control ( -Y) from the menu. When machine control is turned on, red arrows appear in the machine control button. In EditView, when the external machine is shuttling forward or backward, an indicator below the external sync button shows the approximate shuttle speed. When the external machine reaches a speed of 1x, the indicators turns clear.
You must have external sync on in order to use machine control. Turning external sync off automatically turns off machine control. External sync is turned off and on by selecting External Sync (−T) from the menu. When external sync is turned off, machine control is also turned off.

The Machine ControlPrefs... command sets the protocol, port and AMPEX address for the external machine.

The hardware setup for implementing machine control depends on what type of machine you are connecting to. The three types of machine protocols described below are Sony, Ampex and Ampex using a Lynx transport controller.

You can use either the Printer port or the Modem port of the Macintosh to connect to the Terminal port of Synclavier Digital system.

When connecting to a Sony machine, se the Preferences Protocol to Sony and connect the cables as shown below. When connecting to an AMPEX machine, set the Preferences Protocol to Ampex and connect the cables as shown below.

* Sony and Ampex machines must have time code reading capability.
When connecting to a Lynx machine with V-type software (V404-42 or higher), set the Protocol to Ampex and connect the cables as shown below.

Refer to the Lynx manual to set the Machine Type and Address. If you are controlling an audio deck with Lynx, set Lynx to Lifter Defeat Mode if the source tapes contain discontinuous time code.

** You can also use house sync.
**Backing Up**

Use the WangDAT or Patriot tape drive to back up DTD projects, tracks and cues. Cues can also be backed up to a system hard disk or optical disk (although this is not meant to replace tape backup). You can recall backed up projects, tracks and cues to the DTD. Backup procedures are performed from the Project Directory (O page) and Track Display (P page).

**WangDAT™ Tape Drive**

Because you record directly to the hard disks in your DTD system, the sounds you record remain intact even when you turn off the system. To make room for new projects, however, you may want to back up completed projects and cues to WangDAT tape drives.

WangDAT tape drives are mounted vertically in the DTD control unit.

![WangDAT Tape Drive Diagram](image)

When you insert a WangDAT tape, make sure the arrow on top of the tape cartridge points toward the drive.

The yellow **status light** on the drive blinks when a cartridge is inserted or ejected. The light is on when the tape is ready to use. The green **access light** on the drive is on when data is being read from or written to the tape. The light is off when the tape is not in motion and it is safe to insert or remove the cartridge. To remove a tape, press the **Eject** button on the WangDAT drive.

To protect a tape from accidental erasure, manually push open the lock window on the back of the cartridge. You can load a locked tape onto the DTD, but you cannot record on the tape until the cartridge is unlocked. Push the lock window closed to unlock the cartridge.
Project Backup

We recommend that you store only one project on a tape. However, it is possible to store several projects on a tape.

1. Insert the tapes into the WangDAT drives that correspond to the project tracks.
2. If you want to append a project to the end of the tape, select the Skip All command in the Project Directory to skip to the end of recorded projects. The yellow status light blinks until the tape locates the correct position.
3. Select either the Backup Project command (to back up a single project) or the Backup All command (to back up all projects on the DTD). The project is copied to the tape location you indicated. Previously recorded projects at this location are erased. When project backup is completed successfully, the current project’s Mod status on the Project Directory is reset to No.
4. If desired, verify that the tape backup was successful. (See “Verifying the tape backup” later in this section.)
5. Press the Eject button on each drive to eject the tape cartridges.
6. Label each cartridge with the project name and track numbers.
7. Repeat the backup procedure on a second set of tapes for added security.

If the project uses fewer than half the total number of tracks available, odd-numbered tracks are backed up first, followed by even-numbered tracks. You can minimize backup time by recording on odd-numbered tracks only. For example, backing up a recording on Tracks 1 and 3 takes half as long as backing up the same recording on Tracks 1 and 2.

Track Backup

Use commands on the Track Display to store individual DTD tracks on tape.

Track backup is designed for storing individual tracks; it is not compatible with the project backup format. You should keep track backups on separate carefully labeled tapes.

1. Insert the tape cartridge into the WangDAT drive that corresponds to the track you want to back up.
2. If you want to append a track to the end of the tape, select the Skip All command in the Project Directory to skip to the end of recorded material on the tape. The yellow status light blinks until the tape locates the correct position.
3. Select the Backup Track command in the Track Display. The track is copied to the current position on the tape. Previously recorded tracks at this location are erased. Track backup does not reset the project’s Mod status on the Project Directory.

Check the instruction line near the bottom of the display. If “Backup Completed” appears, the backup was successful. If any other message appears, use a different set of cartridges and repeat the backup procedure starting at step 1.
4. If desired, verify that the tape backup was successful. (See “Verifying the Tape Backup” later in this section.)
5. Press the Eject button on the drive to eject the tape cartridge.
6. Label each cartridge with the project name and the track number.
7. Repeat the backup procedure on a second tape for added security.

Verifying the Tape Backup

The verification software will detect if data on the tapes cannot be read for any reason such as medium errors on the tape or hardware problems with the cartridge. It can also detect data errors (noise) that were introduced by cabling or other hardware problems in the system during the data transfer to tape. The software will not detect noise errors that were already in the DTD audio before the transfer. Nor will it detect all types of memory errors introduced by hardware problems during the backup process.

Although most errors that could occur during tape backup can be detected, you cannot directly compare the data on the tape with the data on the DTD. The only completely reliable way to verify a backup is to reload the data and listen to it.

Projects backed up with Release 2.1 or later cannot be reloaded onto a system running earlier software. However, projects backed up with earlier software can be loaded by Release 2.1 or later.

You can verify a backup once the message “Backup Completed” has appeared. Select the Home command from the Project Directory. Perform a Verify or a Verify All command of the project or track that you want to verify. The message “Backup Tape is Now at End” or “One Project has been Skipped” means the track or project was accurately backed up.

The message “Data errors were encountered in this project” indicates a serious hardware problem. If this or any other hardware error message appears, call your Synclavier Company Customer Service Representative.

Storing and Recalling Cue Directories

All the cue definitions (track location, duration and editing information) in the current project can be stored in a data file on the system hard disk. This file can provide security, in case something should inadvertently corrupt your original cue directory.

Select the Audio Event Editor, and display its Cue Store/Recall panel (CUE STOR).
In the field labeled **File**, type the desired data filename or treename. Click [DTD-to-File] and then [OK] in the dialog when you want to store the file. The cue definitions are stored in the data file, replacing any cue information previously stored in that file.

To recall a file, follow the same instructions, except click [File-to-DTD] instead. The cue definitions stored in the data file are recalled to the current project.

**Storing and Recalling Individual Cues**

Another procedure that guards against loss of data is backing up cues to an optical disk. When you store cues on the optical disk, the sample rate is the same as the sample rate of the project. No sync or track information is saved with the cue.

Use the Audio Event Editor’s Optical Transfer panel (OPT XFER) to store to optical disk. Click the Fold Out button near the top right of the panel to display sound files on the optical disk. The right side shows the caption and categories that will be stored with the current cue. The default category is DTD:<current project>.

At the bottom of the panel, the toggle button “Free space” or “Free time” indicates the percent of available directory space (Dir) and the percent of available sample memory (Data) on the optical disk. Free time indicates the amount of time available on the optical disk for mono cues at the given sample rate.

If you want to change captions or categories, make sure the correct cue is displayed in the Name field and type changes into the Captions and Categories fields. Categories can also be added by clicking a category name on the left. Click the Lock button if you want to keep the same caption and/or categories from one cue to the next.

Click STORE CUE and then [STORE] in the dialog when you are ready to store to optical disk.
Recalling Projects

You can recall entire projects from the tape backup system onto the DTD.

1. Insert the desired tape cartridges into the appropriate WangDAT drives.

2. If you want to recall an individual project, use the Skip command in the Project Directory to position the tape at the desired project. The yellow status light blinks until the tape reaches the desired location.

3. In the Project Directory, position the cursor on the line where you want the project loaded.

4. Select either the Load/Add Project command (to load a single project) or the Load/Add All command (to load all projects), and type LOAD when the prompt appears. The appropriate projects are loaded onto the DTD at the location indicated by the cursor in the Project Directory. Any project at that location is overwritten.

   If you have used the Erase All command to reconfigure for one track per drive, leaving you with half as many tracks available, you cannot recall projects from even-numbered tracks.

When you record a project with your system configured for a greater or fewer number of tracks than the standard configuration, you will normally reload that project with the system in the same track configuration. However, under certain conditions, a project that was backed up when the system was configured for fewer tracks can be reloaded onto a system now configured for more tracks. Similarly, a project that was backed up while the system was configured for more tracks can be reloaded onto a system now configured for fewer tracks.

For example, you might start a project with a 16-track configuration, use only eight tracks and find that you need more audio time per track. Or, you might start a project with an 8-track configuration, use less than half the time available and find that you need more tracks. There are two rules to remember when doing this kind of reloading—

- The number of tracks currently available must be equal to or greater than the number of tracks being loaded onto the system. For example, you cannot load 12 tracks of audio onto a system currently configured for eight tracks.
- The length of the project being loaded must be equal to or less than the time available in the current configuration. For example, you cannot load a 20-minute track onto a track that is only 13 minutes long.

If you backed up a project and then reconfigured your system for more tracks, you can reload the project, provided the length of the project is not greater than the time available.
Recording and Editing

LOAD
ADD

Tape 1
1 2
3 4

Tape 2
5 6

Tape 3
7 8

Drive 1
1 2 3 4

Drive 2
5 6 7 8

Drive 3
9 10 11 12

Drive 4
13 14 15 16
1. Insert the first tape (containing audio from tracks 1 and 2) into WangDAT drive 1, and the third tape (containing audio from tracks 5 and 6) into WangDAT drive 2. If desired, use the Skip command in the Project Directory to position the tapes.

2. In the Project Directory, position the cursor on the line where you want the project loaded.

3. Select the appropriate Load command, and type LOAD when the prompt appears.

4. When recording stops, eject the two tapes.

5. Insert the second tape (containing audio from tracks 3 and 4) into WangDAT drive 1, and the fourth tape (containing audio from tracks 7 and 8) into WangDAT drive 2. If desired, use the Skip command to position the tapes.

6. Select the same Load command, but type ADD when the prompt appears. Audio from the second and fourth tapes is added to the project created by loading the first and third tapes.

If you backed up a project and then reconfigured your system for fewer tracks, you can reload the project, provided the number of project tracks is not greater than the number of tracks available. If the project is the first project on the backup tapes, you can load all the tracks with the Load Project command.

1. Insert the first tape into WangDAT drive 1.

2. Insert the second tape into WangDAT drive 3.

   This is drive 3, not drive 2.

3. In the Project Directory, position the cursor on the line where you want the project to be loaded.

4. Select the appropriate Load command, and type LOAD when the prompt appears. Tracks 1 and 2 are loaded onto Winchester 1 (and tracks 3 and 4 are automatically loaded onto Winchester 2). Tracks 5 and 6 are loaded onto Winchester 3 (and tracks 7 and 8 are automatically loaded onto Winchester 4).

   If the project is not the first project on the tape, each track must be loaded separately as described later in this section.
Recalling Tracks

You can recall a track from either a project or track backup tape. If you recall from a *track* backup tape, the track can be recalled to either of the two DTD tracks corresponding to that tape drive. If you recall from a *project* backup tape, each track will be recalled to its original track.

1. Insert the desired tape into the appropriate WangDAT drive.
2. In the Project Directory, position the cursor on the project into which you want the track loaded.
3. Use the Skip command to locate the track you want to recall.
4. Set the selected track status to *READY*.
5. In the Track Display, select the Load Track command.

The track is loaded onto the DTD at the specified location. Any track at that location is overwritten.

Since each WangDAT drive corresponds to a Winchester drive, you can bounce a track by storing it on a track backup tape in one drive and recalling it from the same tape placed in another drive.

If you have used the Erase All command to reconfigure for one track per drive, leaving you with half as many tracks available, you cannot recall tracks from even-numbered tracks.
Displaying Sounds

All newly recorded DTD cues, as well as sounds stored on optical disks and Winchesters and in poly RAM, are cataloged in the Librarian. Sounds on these volumes can be searched, auditioned and placed in a sequence from the Librarian.

Selecting a Volume

A “volume” is any sound storage medium, including the DTD, the hard disks, optical disks, sequences and poly RAM. The Index button lists all currently available volumes—offline and online. (“Online” refers to any volume that is currently available for playback. “Offline” generally refers to optical volumes that are not currently in the drive.)

Summary of how to select a volume and category of sounds—

1. Click and hold the Index button on the Librarian.
2. Select a volume to view.
   The volume and its categories of sound appear on the left. All sounds on the volume appear in alphabetical order on the right.
3. Select an individual category to view by clicking its name.
   Only sounds contained within the category are displayed.
4. To view all sounds on the volume again, click the volume name displayed at the head of the category list.

The Index button is used to select a volume to view. Click and hold the button to select one or all volumes from the menu. A headphone icon next to the name in the menu means the volume is online.

The volume and its categories, catalogs or projects appear on the left and a list of all sounds on the volume appear on the right. To view the sounds on a particular category, catalog or project, double-click on its name. To select an array of volumes, hold down the Shift key while selecting. To select individual volumes, hold down the Option key while selecting.
Sounds are displayed in alphabetical order on the right. To view all sounds on the volume again, click the volume name under the Index button, or select the volume name from the Index button.

To view the contents of all optical volumes at once, select All Volumes from the Index button. (This may take some time the first time. A dialog appears that you can use to cancel the loading of individual volumes.) Once loaded, the names of all optical volumes appear on the left and the names of all sounds on all volumes, sorted by volume name, appear on the right. You can view selecting volumes by holding down Shift to select an array of volumes or the Command key to select individual volumes to display. the sorted contents of the selected volumes appear on the right side of the window.

The Librarian can view the contents of any volume, but to actually audition a sound, the volume must be online. To put an optical volume online, insert the volume into the drive and select the Mount Optical command from the TransferMation File menu, or click the mount button next to the volume name.

Any online volume appears with a headphone icon in the mount button.

---

**Viewing Sound Information**

The Librarian displays information about each sound. When new cues are created, the Librarian listing updates automatically.

The Librarian cannot keep up with large changes performed in the RTP, such as creating or deleting tracks or projects. In such cases, you must update the volume manually using the File menu Update command.

Different information is shown depending on whether it is the DTD, poly RAM, a hard disk, sequence or optical disk that is being displayed. (You can also see sound information by selecting a sound and choosing Info from the Window menu.) The width of each column can be adjusted by dragging the vertical divider between the columns. As the cursor passes over the column divider, arrows appear, which can be clicked and dragged to alter the width of the column.
These columns of information also can be deleted or rearranged to display only the information you want.

- To delete a column, select a column heading by clicking on it and press the Delete key, or -X.
- To add a column, point the cursor at the column divider where you want to add a column. When the arrows appear, hold the Shift key down, and click and hold. A menu of column headings appears. Select from the list to insert a column of information.

The proportional arrangement of the entire window can be altered by moving the boundaries between fields. As the cursor passes over one of these boundaries, arrows appear which can be used to drag the boundary. Arrows appear when you cross the boundary between the left and right sides of the window and when you cross the boundary between the Find field and the number of items found.

The arrows can also be used to turn on proportional resizing. If the Option key is held down while dragging the arrows, the fields will subsequently resize proportionally whenever the resize box in the lower right corner is dragged.

## Selecting and Auditioning Sounds

Use the Tab key to quickly move back and forth between the left and right sides of the Librarian window. Select by clicking a name, or by using the arrow keys to move up and down in the list.

Audition a sound by selecting it and then pressing F12, or by selecting the **Audition** command from the File menu. To audition a sound automatically on selection, first activate the **Audition On Select** command from the File menu. When active, a sound will audition immediately upon selection. If you hear a beep, this indicates that the sound is not online. The volume must be mounted in order to hear the sound.

Overview of how to audition an optical disk sound—

1. Insert the optical disk into the drive.
2. Select the volume name from the Index button.
3. Press the mount button, or select the Mount Optical command from the File menu.
   The optical is loaded and a headphone icon appears in the mount button.
4. Select a sound and press F12 to audition.
Searching

A search finds a specific string of text in a name or caption. A “first occurrence” search can be used on either the category or sounds side of the Librarian. Locate the cursor to the side you want to search. Type one or more letters. The list scrolls to the first occurrence of the typed string.

A more extensive search can be performed in the sound list. Type one or more letters or words into the Find field. A space between words is interpreted as “and,” adding delimiters to the string. A comma between words is read as “or,” adding more variations to the search.

For example, the following search would find all sounds containing a reference to “subway”:

By adding “brake,” the search would find all sounds containing a reference to both “subway” and “brake”:

Adding a comma constructs a search that looks for any sound containing either “subway” or “brake.” This search would net more sounds than the previous searches:

Add as many words or phrases as you want, using spaces and commas to limit or expand your search. Press the Return key to begin searching through the names and captions in the displayed list. The resulting list shows all sounds containing the search string.

The Librarian remembers the last 32 Find strings that you entered. To scroll through the list of strings, select the Find field and press the up or down arrow key. The strings remain in the Librarian until you power down.

When All Volumes is selected from the Index menu, you can view and search the contents of selected volumes. The Shift key selects an array of volumes to search. The Command key selects individual volumes to display. The results of the search are sorted by volume on the right side of the window.

Overview of how to search for a sound—

1. Select the volume or category to search from the Librarian. (The volume does not have to be online.)

   The sounds associated with that volume or category are displayed in the sounds list. (Currently you cannot search by categories.)

2. Enter the search text into the FIND window using spaces and commas between words to limit or extend the search.

3. Press Return to begin the search.

   Depending on how extensive a search is taking place, the search may be completed immediately or take a few seconds. The results are displayed in the sounds list.
Librarian Index Files

The Librarian uses an index file system on the Macintosh to display and search through information. The NED Index Folder on the Macintosh contains an index file for each of the volumes that appears on the Librarian Index button. This includes index files for each optical volume, the DTD projects, sequences and all sound files stored on the W0 and W1 hard drives.

These index files are created by the Librarian from information it receives from the Synclavier and DTD computers. In the case of optical volumes, the Macintosh index information is taken directly from the index files stored in the .INDEX subcatalog on the system hard drive. In all other cases, as with the DTD project and cue index, the Librarian actually searches the hard drives and collects the information it needs.

In many cases the Macintosh cannot automatically keep its copies of the index files up to date. For example, when changes are made to a optical volume, such as adding sounds from an RTP display, the index file in .INDEX is updated automatically by the RTP, but the equivalent file in the NED Index Folder is not. Unless the index files on the Macintosh are manually updated by the user, the Librarian will be using information that is out of date.

It is up to the user to make sure that the index files on the Macintosh are kept up to date.

There are three commands in the File menu that update or import new or changed volumes. To update the currently displayed volume in the Librarian, select Update. To update all volumes, select Update All.

The Update All command is the only way to ensure that all index files on the Macintosh are present and up to date.

Overview of how to update a volume—

1. Select the volume (online or offline) that you want to update from the Index button. (This may be an optical disk or the DTD, for instance.)
2. Select Update from the File menu to update the current volume.
   Select Update All Volumes from the File menu to update all volumes.
The **Import New Volumes** command can be used to create a new optical index file. This may be a newly purchased optical volume, or someone else’s optical that you are using in your system for the first time. You must first create an index file in .INDEX by loading the new volume from the Optical Disk Display. Then select Import New Volumes from the File menu. The volume will now be listed in the Index button.

Overview of how to add a new optical volume to the Index button—

1. Insert the optical disk into the drive.
2. If you have not already done so, create an index file using the Update command on the Optical Disk Display (R-page).
3. In the Librarian, select Import New Volumes from the File menu.
   
   The volume can now be selected from the Index button. If the volume is online, sounds can be auditioned.

The chart below tells how to keep your volumes up-to-date. It is a good idea to update the Macintosh index files on a regular basis, as you can run into problems if volumes get out-of-date. Updating a large volume can take quite a while, so it is best to schedule the tasks listed below (such as archiving new files to an optical volume) when you have the time to also update your Macintosh index files.

<table>
<thead>
<tr>
<th>Type of volume</th>
<th>When to update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct-to-Disk</td>
<td>The DTD index file is updated automatically whenever you are recording cues. You should do a manual update after you create a new project, load projects from tape or erase a project.</td>
</tr>
<tr>
<td>Optical volumes</td>
<td>Optical index files should be updated manually after you change the sounds on a particular volume (add new ones, delete sounds, rename or recategorize).</td>
</tr>
<tr>
<td>Hard drives</td>
<td>The hard drive index files should be updated manually after you add or delete sound files or subcatalogs from your hard drives, or have just run the Shuffle Utility.</td>
</tr>
<tr>
<td>poly RAM</td>
<td>Does not need to be updated manually.</td>
</tr>
<tr>
<td>sequence files</td>
<td>The sequence index file should be updated manually after you add or delete sequence files or subcatalogs from your hard drives, or have just run the Shuffle Utility</td>
</tr>
</tbody>
</table>

If you are having problems running the Librarian and you suspect that your index files are corrupted or out of date, remove the NED Index Folder from your Macintosh and then use the Update All command.
User Index Files

The list displayed on the right side of the Librarian may be a volume index or the results of a search. This listing can be saved as a text file and printed out. To do this, display the Librarian information you want to convert to the text file and then select the Save As... command from the Global Menu. A dialog appears for saving the information as a Teach Text file.

To open the Teach Text file, double-click the file icon, or open it from within a word processing program.

You can also create a text file, such as a list of sounds on CD, and import it into the Librarian to view and search as an index file. In order to import a text file, it must contain columns of text separated by tabs; the first row is treated as the column headers. For the time being, each column header must match the spelling of one of the existing Librarian headers—

Volume, Name, Caption, Duration, Type, kHz, Trk, Loop, Sync Time, Mark Offset, Meter, Tempo, Offset, Mode

Save the file as Text Only (ASCII). Import the file back into the Librarian by selecting Import Text from the Librarian Local Menu. A dialog similar to the one above appears from which you can select the file to import. Save the imported file in the NED Index Files folder. To view a user index file in the Librarian, select it from the Index button.

If you do not save the user index file in the NED Index File folder, it will not appear in the Index menu the next time you start up.
Printing

You can save the contents of the Librarian window to a text file, which can be printed. To do this, display the Librarian information you want to convert to the text file and then select the **Save As Text** command from the File menu. A dialog appears for saving the information as a Teach Text file. When you open the Teach Text file, double-click the file icon, or open it from within a work processing program.

You can also create a text file, such as a list of sounds on CD, and import it into the Librarian to view and search as an index file. In order to import a text file, it must contain columns of text separated by tabs; the first row is treated as the column headers. Each column header must match one of the existing Librarian headers: Volume, Name, Caption, Duration, Type, kHz, Trk, Loop, Sync Time, Mark Offset, Meter, Tempo, Offset, Mode. Save the file as Text Only (ASCII).

Import the Text Only file into the Librarian by selecting **Import Text** from the TransferMation File menu. A dialog appears from which you can select the text file to import. Save the imported file in the Index Files folder. To view this user index file in the Librarian, select it from the Index menu.

It is up to the user to make sure that the index files on the Macintosh are kept up to date. If you do not save the user index file in the Index File folder, it will not appear in the Index.
Cue Editing

Cue editing is non-destructive. During the editing process, the In and Out points of the cue may change, or audio may be removed, but the source audio remains undisturbed on the DTD track, just as you recorded it.

Recalling and Displaying a Cue

Cue editing is performed on the Audio Event Editor’s Cue Editor panel (CUE EDIT). The currently selected cue appears on the shuttle bar of the Cue Editor. It is defined by the In and Out icons on the bar.

You can recall a cue from the Librarian, but you can also recall a project or a cue from the Cue Editor. Click the Proj scroll arrow to scroll to a project.

Proj: 2. New D

Click the scroll arrows in the upper left corner to scroll to a cue in the project. (The inverted take button is used to increment the name of the cue.)

Ambience

The scan bar represent the signal on the shuttle bar. The box inside the bar is used to play the cue and locate edit points. When you drag the scan box, the cue plays. When you click in the bar, the scan box moves to the click location and plays.

The scrub bar represents .5, 2.0 or 5.0 seconds of the shuttle bar, centered on the scan box location. It is used for finer playback and location of edit points. When you drag the scrub box the cue scrubs. When you click in the bar, the scrub box moves to the click location and plays.

Many of the buttons around the shuttle bar are used for display purposes—
• Click ZOOM IN and ZOOM OUT to display more or less detail of the cue.
• Click CUE to center the cue on the shuttle bar.
• Click HOLD to freeze the shuttle bar location and recall a different cue to the shuttle bar.
• Click PROJ to bring all cues on a selected track to the shuttle bar. (In and Out points define the current cue.)
• Click .5, 2.0 or 5.0 seconds to set the dimension of the scrub bar.
• Click SHOW WAVE next to either the scan or scrub bar to display the cue as a waveform. (This may take a few seconds.)
• Click SHOW CUES to display the cue name on the shuttle bar.
• Click CLEAR EDITS twice to bring the entire track as it was originally recorded to the shuttle bar. (In and Out points are place at either end of the track.)

Another way to get a closer look at a specific portion of a cue is to use the magnifying glasses on either end of the shuttle bar. The magnifiers are used to define the area of the cue you want to look at. They work sort of like the zoom commands, except that they specifically define the start and end points of the area you want to zoom into. Individually drag the left and right magnifiers onto the shuttle bar. The left magnifier defines the beginning of the shuttle bar and the right magnifier defines the end of the shuttle bar.

To look at audio adjacent to the present shuttle bar location, drag the small box at the base of either magnifier across the shuttle bar. When you reach the area you want to display, release the magnifier.

---

**Cue Playback**

There are two basic ways to play back the current cue. They can be used from any location playback location—

• Click to play back the entire cue.
• Click and hold to play back until you release.

To play back the cue from the shuttle bar, click before the In icon or between the In and Out icons. You can also click in the scan bar or drag the scan or scrub box.
You can also play back using the motion control buttons. Each click of the high speed play button doubles the speed.

Each click of the slow speed button cuts the speed of playback by one-half. When moving forward or backward at speeds greater than twice normal speed, the movement can be attenuated by pressing the opposite button.

The function keys F5-F12 on your Macintosh keyboard are used for special playback functions. Keys F5-F8 lock your cursor to icons on the shuttle bar. When you are locked, the trackball and the icon move together. As the icon moves, it scrubs.

Function keys F9-F12 become motion control buttons when icons are locked. For example, if you press F5 to lock to the In icon, you could scrub the icon with the trackball, or you could press F9 to play from the In point. To unlock the trackball and the icon, press the same function key again.

Use the function keys on the Macintosh keyboard in the following ways—

<table>
<thead>
<tr>
<th>button</th>
<th>function</th>
<th>button</th>
<th>function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F5</td>
<td>locks to In</td>
<td>F9</td>
<td>play from</td>
</tr>
<tr>
<td>F8</td>
<td>locks to Out</td>
<td>F10</td>
<td>pause</td>
</tr>
<tr>
<td>F6</td>
<td>locks to Edit In</td>
<td>F11</td>
<td>play to</td>
</tr>
<tr>
<td>F7</td>
<td>locks to Edit Out</td>
<td>F12</td>
<td>toggle between scan and scrub</td>
</tr>
</tbody>
</table>

Trimming a Cue

Trimming involves editing audio from the head and/or tail of the cue. This is simply done by dragging the In and Out points on the shuttle bar. The cue scrubs while you drag so that you can precisely locate the new point. Use the F-keys described above to help you scrub and play the edit points. Or display a waveform of the cue to locate particular audio. When you play the cue, you will hear the edited version. No audio has been erased, the cue just points to a different place on the disk.

Another way to trim a cue is to use the In and Out take buttons in the lower right corner of the Cue Editor. (The Out time toggles to Duration by clicking and holding Out and moving the trackball back and forth.) Play the cue and click the In take button where you want to start the cue and click the Out take button where you want to end the cue. The In and Out points move to the new times.
You can also type a time into either one of these fields.

The shuttle bar represents a certain segment of time on the DTD track. If you enter a cue In or Out time that is not represented on the shuttle bar, the In or Out icon will be visually enclosed in a box at the end of the bar, indicating that the In or Out time is beyond the end of the shuttle bar.

You can also move the entire cue by dragging the small box at the base of either the In or Out icon. The duration is unchanged while you drag.

---

**Saving and Protecting Cues**

As you make new cues, you should save them. To save a new cue—

1. Type name into the cue name field.
2. Toggle Proj to Capt and enter a caption of up to 30 characters.
3. Click the Save button.

The cue is saved in the Librarian.

You can protect the cue on the shuttle bar from being accidentally edited or deleted by using the protect button in the upper right corner of the Cue Editor. When you click the protect button, you can continue to edit, but you will not be able to save the cue under the same name. If you want to save an edited version of the cue, you must rename it before saving.
**Advanced Cue Editing**

There are many different types of edits that can be performed. Many of these involve using edit commands and temporary storage buttons.

---

**Edit Points**

You can edit a specific area of audio within the cue. Extraneous words can be removed, a word from one cue can be inserted into another, audio can be slid or filled with leader, all without destroying the original audio.

These kinds of edits are performed using edit points, which are placed using the scissors icons at either end of the shuttle bar.

To place an edit point—

1. **Drag the left scissors to a point between the In and Out points on the shuttle bar.**
   This is where you want your edit to start.

2. **Drag the right scissors to the point between the In and Out icons where you want your edit to end.**

Another way to place edit points is to use the Edit and Out take buttons in the lower right corner of the Cue Editor. (The Out time toggles to Length by clicking and holding Out and moving the trackball back and forth.) Play the cue and click the Edit take button where you want to start the edit and click the Out take button where you want to end the edit. The Edit In and Edit Out points move to the new times. You can also type a time into either one of these fields.

To move the entire cue, drag the small box at the base of either scissors icon or in the middle of the horizontal bar connecting the edit points. The duration is unchanged while you drag.
To play an edit, use the F-keys described above, or click between the edit points. You can also click the Edit play button.

If you have completed no further editing than placing edit points on the shuttle bar, you can remove the edit points by clicking the empty scissors box at the end of the shuttle bar. To recall them again, just click the Undo button at the base of the edit Take button.

Editing Features

While editing, you will periodically want to save a working version of the cue or edit for future reference. When you first recall a cue, it is stored in the CUE button. While editing, the CUE button is constantly updated with the current version of the cue on the shuttle bar.

The CLIP and REEL buttons are similar to a Macintosh clipboard. Each one is a working storage area for use during editing. There is no difference between CLIPS and REEL, except for CLIP 1, which is the default clipboard. Each time you store something in a CLIP or REEL its previous contents are replaced. If you want to keep a permanent copy of a cue, save it. Saved cues are listed in the Librarian.

Many of the dialogs that result from an edit command ask if you want to use a CLIP or REEL. Respond by clicking on the button you want to store something in.

To recall the contents of a CLIP, REEL or CUE to the shuttle bar, just click the button. But remember, when you do this, you replace the current cue on the shuttle bar, and all of the edits you may have performed. You may want to save the cue to a CLIP or REEL first using the COPY command.

The LEADER button stores the equivalent of blank tape. Use it with edit commands that ask you if you want to fill or paste with leader.
Edit flags appear in the cue when you perform an edit that adds to or deletes from the cue. An $E$ flag marks the point where the edit took place. This edit flag can be dragged to add or delete audio on either side of the flag. If you do not want to see the edit flags (depending on how you edit, there can be quite a few), click the SHOW EDITS button.

The track(s) on which a cue is recorded highlights when the cue is on the shuttle bar. DTD tracks can be selected by clicking a track number.

Save times in the temporary memory buttons. Select a time and drag it to a memory button. Recall the time by placing your cursor in the time display where you want to retrieve the time, and then clicking the memory button.

### Using a Command

The command buttons below the shuttle bar are used to perform specific edit operations on the cue on the shuttle bar.

To use an edit command—

1. Click the command.
2. Respond to the dialog.

   Some commands require you to specify source material for the operation. The default source and destination for any function is CLIP 1. This button is similar to the Macintosh clipboard.

   If you want to use different source material than what is suggested in the dialog, click the CLIP, REEL or LEADER button containing the alternate source material.

3. Some commands require additional selections. These will be listed in the dialog.
4. Click the command again to active it.

<table>
<thead>
<tr>
<th>command</th>
<th>function</th>
</tr>
</thead>
<tbody>
<tr>
<td>COPY</td>
<td>Copies edit or entire cue to selected CLIP or REEL button. Cue remains on shuttle bar.</td>
</tr>
<tr>
<td>CUT</td>
<td>Removes edit from cue and places it into selected CLIP or REEL button. Duration of cue is shortened.</td>
</tr>
<tr>
<td>CLEAR EDITS</td>
<td>Click once to clear a selected CUE, CLIP or REEL button. Click twice to bring the entire track to the shuttle bar. (In and Out points are placed on either end of the project.)</td>
</tr>
<tr>
<td>CHAIN</td>
<td>Splices contents of selected CUE, CLIP or REEL button to end of cue. Duration changes.</td>
</tr>
<tr>
<td>DELETE</td>
<td>Removes edit from cue. Duration changes.</td>
</tr>
<tr>
<td>DELETE CUE</td>
<td>Deletes selected cue from Librarian. Cue remains on shuttle bar.</td>
</tr>
<tr>
<td>EXCHANGE</td>
<td>Swaps cue or edit on shuttle bar with contents of selected CLIP or REEL button.</td>
</tr>
<tr>
<td>EXTRACT</td>
<td>Makes the edit the current cue on shuttle bar.</td>
</tr>
</tbody>
</table>
Recording and Editing

FILL  Replaces edit with contents of selected CLIP or REEL button. If fill material is shorter than edit length, loops material to fill entire edit.

PASTE  Inserts contents of selected CLIP, REEL or LEADER button into edit start point. Edit flags appear at start and end of pasted material.

RECALL  Recalls a cue from any project. (If the cue is recalled from a project with a different sampling rate, the cue plays at the sampling rate of the current project.)

RENAME  Renames and saves the current cue. The original version of the cue is overwritten. Be careful how you use this command.

SLIDE  Places an edit in a different location without changing the duration. See “SLIDE—Dragging edit segments”

TRANSFER  Places current cue onto keyboard as first partial timbre
TO POLY  of keyboard timbre. Two-track cue becomes stereo sound file.

---

Blocking

You can break a single cue into two or more smaller ones by using the **Block** button. Smaller cues are sometimes easier to edit. To block a cue, bring it to the shuttle bar and play it. While the cue plays, click the Block button whenever you want to make a new cue. The cue name increments as you block.

If you record a track from the Track Display or from the Record panel using the Punch In mode, your track does not contain cues. You can create cues on the track by making the entire project into a single cue and then blocking.

1. Recall the project containing the track you want to block into cues.
2. On the Cue Editor, click the CLEAR EDITS button twice. This places the entire project on the shuttle bar.
3. If you want to trim off excess audio at the beginning of the cue, drag the In flag.
4. If you want to trim off excess audio at the end of the cue, drag the Out flag to the end of the audio.
5. Enter a name in to the cue name field.
6. Click the Save button. The entire project is now saved as a single cue.
7. Select individual tracks and block into cues.
Pasting with Leader

You can insert leader at any point in the cue using the PASTE command.

1. Click PASTE.
2. Click LEADER.
3. Click the Len time field and enter the length of leader you want to insert at the Edit In point.
   or
   Click LOOP PASTE in the dialog to fill the entire edit with leader.
4. Click PASTE to complete the edit.

Sliding

Sliding is similar to cutting and pasting. The difference is that when you slide an edit, the duration of the cue and its synchronization remain unchanged. There are two types of slide—

Displace  Cut an edit from its present location and drag it to a new location where it is pasted. No audio is erased or replaced.

Fill      Drag an edit to a new location and replace the gap left behind with leader or the contents of a clipboard button. The duration of the cue does not change. This is the default mode.

To perform a displaced slide—

1. Designate an edit segment.
2. Click SLIDE and then click DISPLACED AUDIO.
3. Drag the edit segment to a new location. The duration of the cue is locked as you drag.
4. Click the SLIDE command when you are finished.
A preview feature allows you to hear the edit before it is actually completed. To do this, click SLIDE and move the edit. Before clicking SLIDE again to complete the edit, click PREVIEW SLIDE instead. You can now hear the edit. If you are not satisfied, click PREVIEW SLIDE again to turn it off and continue editing. When you are satisfied, click SLIDE to complete the edit.

The filled slide works differently. You can fill the gap left behind after sliding an edit with audio from a clipboard button. In this way, you can slide over words you want to delete, and then fill the gap left behind with leader or other audio.

To complete a filled slide—

1. Designate an edit segment.

2. Click the SLIDE command and drag the edit to the desired location.

3. If you want to fill the gap left behind with something other than the contents of CLIP1, click the CLIP, REEL or LEADER button.

4. When you are satisfied with the edit, click SLIDE.
**Adjusting the Volume Envelope**

The beginning and end of the cue can be ramped to increase or decrease the volume steadily over a period of time. The Fade In at the start of the cue ramps up from zero to full volume. The Fade Out at the end of the cue ramps down from full to zero volume.

Cue envelope changes are performed only at the analog outputs. They are not available when using the UDIO ports or the digital bounce feature.

Fade times are entered from the Audio Event Editor’s Cue Trim panel. Enter the length of the ramp in into the Fade In time field. Enter the length of the ramp out into the Fade Out time field. Times are entered in seconds. If the fade length equals or exceeds the duration of the cue, the entire cue is ramped.

You can hear a ramp by clicking either play button.
Chapter 4
Sequencing
Displays EditView

EditView is the primary application from which you can display and edit the sequence and individual events. When editing events, the original audio is not altered. You can always go back to the source audio. To recall a sequence, see the chapter “Projects and Tracks.”

Tracks Display

EditView is displayed as a separate window. Select EditView from the Window menu. When the window is active, a set of pulldown menus appears at the top of the screen.

If is visible in the upper right corner of the EditView window, your Macintosh is successfully communicating with the Synclavier computer. If it is not visible, the communications link has not been established or has been broken. Check that the cables have been properly connected and the correct software has been installed.

If the RTP window is displayed in mid- or half-size, you can view the RTP window and the EditView window at the same time. Use the vertical Scroll Bar to scroll through all 200 tracks. Use the horizontal Scroll Bar to scroll through the sequence.

After opening, EditView remembers its window size and position, zoom factor, machine control port, protocol, and AMPEX address for the next time.

The EditView tracks display graphically represents cues and RAM events (notes and sound files) which can be edited and moved in the sequence.

At the top of the tracks display is the Ruler. The Ruler marks off increments of time in the sequence. The amount of each increment depends on the time format in which the events are displayed. Select the time format from the TransferMation Display menu.

<table>
<thead>
<tr>
<th>time format</th>
<th>increment</th>
</tr>
</thead>
<tbody>
<tr>
<td>beats:measures</td>
<td>1 beat</td>
</tr>
<tr>
<td>seconds</td>
<td>1 second</td>
</tr>
<tr>
<td>minutes:seconds</td>
<td>1 second</td>
</tr>
<tr>
<td>SMPTE</td>
<td>10 frames</td>
</tr>
<tr>
<td>feet:frames</td>
<td>10 frames</td>
</tr>
</tbody>
</table>
The In, Out, and Mark points appear on the Ruler. The **Display Length** indicates the amount of time currently displayed. The time at the center of the ruler is the current sequencer time.

Use one of the following methods to display a different part of the sequence—

- Enter a new time into the current time field.
- Scroll the sequence.
- Use the motion controls.
- Locate to a new time.

All note events on all tracks can be hidden or shown by toggling the **Show Notes** command on the Controls menu. If this command is active before opening a sequence, the note events are ignored and will not be loaded.

To view the sequence in greater detail, select **Zoom In** (-[]) or left detail **Zoom Out** ( -[]) from the Events menu.

The window displaying a rabbit or turtle indicates the screen redraw speed. If you have enough application memory allocated for EditView to operate efficiently, the rabbit appears. If not, you see the turtle. To increase memory, select the EditView application icon from the Finder and choose Get Info from the File menu.

**EditView Track List**

The left portion of the EditView window consists of a Track List. The names and number of each track, as well as the solo and mute buttons, appear here. The currently selected track is highlighted red. To change the selected track, click on the track number, or click in the track area where no event is located.

A track which contains RAM events appears with a musical note next to the track name. (Zoom in for greater detail.) A track which contains cue events appears with a small event icon preceding the track name.

To hide or show all events on a track, click the track name. (All RAM events can be hidden or shown using the Controls command Show Notes.) Track names are edited from the Event List Editor panel of the Audio Event Editor.
Tools

Three tools in the upper left corner of the EditView window are used to activate cursor functions in the tracks display. Select a tool by clicking it or by using its key equivalent (given below).

Double-clicking a tool locks it in that mode until you click another tool. If another tool is chosen with a key press, the locked tool is reselected when the key is released.

<table>
<thead>
<tr>
<th>Name</th>
<th>Tool</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td><img src="image1.png" alt="Select Tool" /></td>
<td></td>
<td>Select events, move handles and scrub.</td>
</tr>
<tr>
<td>Move Tool</td>
<td><img src="image2.png" alt="Move Tool" /></td>
<td>Option</td>
<td>Move events—when the cursor is over a selected event, click and drag in any direction. Use the arrow keys to move a selected event up and down or left and right. Move handles—when the cursor is over a handle, click and drag left or right to move the selected handle. (This tool also appears when the Select tool is placed over a handle.)</td>
</tr>
<tr>
<td>Motion Control</td>
<td><img src="image3.png" alt="Motion Control" /></td>
<td>Control</td>
<td>Advance or reverse the sequencer and track display, and shuttle the tape deck is machine control is on.</td>
</tr>
</tbody>
</table>
Placing Cues

TransferMation allows you to place cues from the Librarian into the sequence in a variety of ways.

The Place Button

A Place button on the Librarian window allows you to set the type of place you want to perform: Paste or Insert. The audio event can then be placed into the sequence at the Current time, the EditView In, Out or Mark time, or the cue Sync time (set from the Audio Event Editor).

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste</td>
<td>Places an event without changing the sync of events on the track</td>
</tr>
<tr>
<td>Insert</td>
<td>Places an event and inserts time, changing the sync of the events which follow.</td>
</tr>
<tr>
<td>Current</td>
<td>Places the start of the event at the current sequencer time</td>
</tr>
<tr>
<td>In</td>
<td>Places the start of the event at the EditView In mark</td>
</tr>
<tr>
<td>Out</td>
<td>Places the start of the event at the EditView Out mark</td>
</tr>
<tr>
<td>Mark</td>
<td>Places the start of the event at the EditView Mark point</td>
</tr>
<tr>
<td>Sync</td>
<td>Places the event at the cue sync time</td>
</tr>
<tr>
<td>Chain</td>
<td>Place one event immediately followed by the next. The first event is placed at the current time. (Chain obeys the Paste or Insert mode but it does not interact with the other place commands.)</td>
</tr>
<tr>
<td>Replace</td>
<td>Replaces the selected EditView event. Select the event to replace before selecting the Replace command. (Replace obeys the Paste or Insert mode but it does not interact with the other place commands.)</td>
</tr>
</tbody>
</table>

Placing

Once you have selected the type of place that you are going to perform, the button on the Librarian places the cue into the sequence. The SEQ TRK field indicates the sequence track onto which the cue will be placed. You can enter a track number by typing, or by using the Keypad + and - keys to increment or decrement the number (the cursor can be located anywhere in the window).
To place an event—

1. Select DTD from the Index button on the Librarian. Projects appear on the left and all cues on all projects appear on the right.
2. If you want to look at only the cues from a specific project, select that project from the left.
3. Select a cue from the sounds list.
4. Select Paste or Insert from the Place button.
5. Select the time to which you want to align the In point.
6. Enter the number of the track on which you want to place the cue into the SEQ TRK.
7. Locate the sequencer to the time at which you want to place the cue.
8. Click the button, or press -P.

When an optical sound is placed on an empty sequence track, the sound is loaded into RAM and the track defaults to a note track. If an optical sound is placed on an existing note track, the sound becomes part of the patch. If an optical sound is placed on a track containing cues, the sound is automatically recorded on the DTD.

Auto Placing

Place a cue automatically into the sequence after recording using the auto commands in the Record button on the Transport panel.

- When Auto Place is selected during recording (and the sequencer is in play), the cue is automatically placed onto the selected EditView track at its sync time (In time). When recording stops, the cue is automatically placed on the sequence track selected in EditView and it appears in the Librarian. If Auto Place is not selected during recording, the cue is only recorded to the DTD.

- If Auto Select is selected when you ready a track, the DTD track and the same number output in EditView are automatically selected.

You can also remove a cue that you have just placed—

- Click the Transport Undo Place button if you want to remove the event from the sequence. This does not erase the cue from the Librarian.
Event Editing

Events are cues or notes which have been placed on sequencer tracks. Editing an event does not alter the original cue or the DTD track. In EditView, events appear as rectangles on the tracks. (Cue events and note events must remain on separate tracks.)

General Editing

There are two modes of editing: event and region. The user is in control of choosing either mode. The available editing features and the result of an edit is different depending on which mode is selected.

A rule of thumb for event editing is that an event or handle must be selected before you can move or edit it. If no event is selected, and you invoke an edit command, EditView assumes you want to do a region edit (explained below). During event editing only the audio associated with the single event is edited. Editing does not affect the synchronization of the entire track, only the event.

To select an event, you must first select the tool. Once the tool is selected, click the event and drag. You can also use the arrow keys to move a selected event up and down or left and right.

Use the tool to select and move a handle. Once the tool is selected, drag the handle with the trackball.

Then use any of the following methods to select a handle—

- Click on it.
- Pull down the Times menu and select a handle time.
- Press the Tab key to select the next handle.

When a cue event is selected, five handles appear as small boxes at the Event Start, Event End, Fade In, Fade Out, and Offset times. When a note event is selected, Event Start and Event End handles appear. Dragging a handle to a different time is one way to edit the event.

Times relevant to the select handle appear at the top of the window. The name of the event and its caption also appear.

Use the Audio Event Editor to edit the name and caption.
The time associated with the currently selected handle is highlighted. Any handle can be moved by selecting its time field and editing it. The result of the edit is graphically displayed in EditView.

Handle times can be locked. A locked handle does not move when other times are changed. Clicking an Arrow changes it to a Tack, and vice versa. Only one handle can be locked at a time. Locking is useful for trimming.

- An arrow appears next to a handle that is unlocked and can be moved.
- A tack appears next to a handle that is locked and cannot be moved.

The Event Duration or Length refers to the duration of an event or the length of a fade or offset, depending on which handle is selected. When Arrows appear next to both times, the Duration (or Length) is locked, and entering a new time into the Duration field moves the event without changing the event length.

The Offset Time is a time within the event that can be synced to the sequence (or picture). The offset can be the beginning of the event, the end of the event (for backtiming) or any point within the event. The Offset Length is the duration from the beginning of the event to the Offset Time.

Select the Control menu **Show Event Captions** to display the event’s caption.
Trimming an Event

Trimming changes the location of an event handle, without changing it’s sync on the track. You can use the trim function in place of dragging the event handles. It is often used to trim audio from the head and tail of an event. You can use the current time, the In time, or the Mark time to trim an event. Select the appropriate command from the EditView Events menu.

<table>
<thead>
<tr>
<th>Trim Command</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trim to Current Time</td>
<td></td>
<td>Moves the selected handle to the current sequence time. The event duration may be changed. If the Event Start handle is trimmed, synchronization is not retained.</td>
</tr>
<tr>
<td>Trim to In</td>
<td>-opt-S</td>
<td>Moves the selected handle to the current In point. The event duration may be changed. If the Event Start handle is trimmed, synchronization is not retained.</td>
</tr>
<tr>
<td>Trim to Mark</td>
<td></td>
<td>Moves the selected handle to the current Mark point. The event duration may be changed. If the Event Start handle is trimmed, synchronization is not retained.</td>
</tr>
</tbody>
</table>

To trim a handle using the In time—

1. Select an event.
2. Drag the In icon to the time at which you want to trim the Event Start.
3. Select Trim to In from the Events menu.
   The Event Start handle moves to the location of the In icon.

Aligning an Event

Aligning moves the entire event in the sequence, changing its sync. You can use the align function in place of dragging the event. You can use the current time, the In time, or the Mark time to align an event. Select the appropriate command from the EditView Events menu.

| Align to Current Time       |      | Moves the entire event and aligns the selected handle to the current time. Event duration is not changed. |
| Align to In                 | -opt-A | Moves the entire event and aligns the selected handle to the In point. Event duration is not changed. |
| Align to Mark               |      | Moves the entire event and aligns the selected handle to the mark point. Event duration is not changed. |
To align an event using the In time—

1. Select an event.
2. Drag the In icon to the time at which you want to sync the Event Start.
3. Select Align to In from the Events menu.
   The entire event moves so that the Event Start is aligned with the In point.

---

**Editing Time Fields**

The following are some general editing features common to all time and numeric fields.

- Any time or numeric field can be edited.
- Type times directly into fields or subfields.
- A single click in a time field selects the entire field; a double-click selects a subfield.
- Use the Tab key to toggle through subfields within a time automatically.
- Use the Option and Command keys with a click to jog a selected subfield up or down.
- Use the Copy and Paste menu commands between entire time fields.

When no event is selected, dashes appear in event time fields.

---

**Volume Envelope**

The overall sound of an event is determined by the shape of its **Volume Envelope**. The sound is altered by moving the handles or changing the volume levels. The **Start Volume** is the volume level at the Fade In handle. It appears when this handle is selected. The **End Volume** is the volume level at the Fade Out volume. It appears when this handle is selected. The **Event Volume** determines the overall volume level for an event within the sequence. It acts as a volume master, keeping the relationship between the Start and End Volume constant. The Event Volume appears when the Event Start, Event End or Offset handle is selected.

To change a volume parameter—

1. Select the volume field.
2. Type a volume level between 0-100%.

Toggle the **Show Volume Envelopes** command in the Controls menu to either show the actual volume envelope, or to view all events as though they were at full volume. (The actual volume level still appears in the volume field.)
## Advanced Event Editing Commands

The following edit commands can be used on a selected event. To perform an event edit using one of the commands from the EditView Edit menu—

1. Select the event.
2. Select the command from the Edit menu.

These commands act differently if an event or a region is selected.

<table>
<thead>
<tr>
<th>Command</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>-Z</td>
<td>Reverses most recent edit of an event or time field.</td>
</tr>
<tr>
<td>Cut</td>
<td>-X</td>
<td>Removes an event region without changing the sync of the following events. Cut material is copied to the clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>-C</td>
<td>Places a copy of an event or time field onto the clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>-V</td>
<td>Merges the clipboard event onto a track beginning at the In point. Sync is unchanged. Or replaces a numeric field.</td>
</tr>
<tr>
<td>Split</td>
<td>-B</td>
<td>Breaks events in two at the In point.</td>
</tr>
<tr>
<td>Insert</td>
<td>-I</td>
<td>Adds the clipboard into the track at the In point, changing the sync of the following events.</td>
</tr>
<tr>
<td>Replace Cue</td>
<td></td>
<td>Saves a cue back to the Cue Directory.</td>
</tr>
</tbody>
</table>
Region Editing

Region editing occurs when an event is not selected. Use the In and Out times to set an edit region.

Setting In and Out points

Deselecting an event puts you in region editing mode. During region editing, event handles are ignored, and you are not restricted to editing discrete events—any region on the track can be edited. Editing a region, however, can affect multiple events and the synchronization of the entire track.

Edit In and Edit Out points define a region on a single track for editing. When a region is defined, the entire track area between the In and Out points is selected, regardless of the start and end times of events. These marks appear on the ruler and in the time fields.

Use one of the following methods to set In and Out points—

- Drag the In or Out icon on the ruler. (Icon does not scrub.)
- Enter a time into the In or Out time field.
- Lock to the In or Out time and scrub.
- Use an F-key to take a time directly into the In or Out time field.

Once an edit time has been selected, the trackball is locked to it for scrubbing. (If the In or Out point is off the screen, the icon moves to where the cursor begins scrubbing.) Click in any open area at the top of the window or press the Enter key to deselect an edit time.

<table>
<thead>
<tr>
<th>F-key</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>F5</td>
<td>If the sequence is playing, the current play time is taken into the In time field. If the sequence is not playing, the cursor time is taken into the In time field.</td>
</tr>
<tr>
<td>F8</td>
<td>If the sequence is playing, the current play time is taken into the Out time field. If the sequence is not playing, the cursor time is taken into the Out time field.</td>
</tr>
<tr>
<td>F6</td>
<td>Selects and locks (or unlocks) the In time.</td>
</tr>
<tr>
<td>F7</td>
<td>Selects and locks (or unlocks) the Out time.</td>
</tr>
</tbody>
</table>
In and Out times can be set at any time, regardless of whether an event is selected. To perform the edit, however, all events must be deselected.

Using Edit Commands

The following edit command can be used on a region. To perform a region edit using one of the commands from the EditView Edit menu—

1. Click the number 1 of the track you want to edit.
2. Set In and/or Out points.
3. Select an edit function from the Edit menu (see below).

<table>
<thead>
<tr>
<th>Command</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>-Z</td>
<td>Reverses most recent edit of an event.</td>
</tr>
<tr>
<td>Cut</td>
<td>-X</td>
<td>Removes a region without changing the sync of the following events.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cut material is copied to the clipboard. If the In and Out points fall</td>
</tr>
<tr>
<td></td>
<td></td>
<td>within an event, the event is split at that point.</td>
</tr>
<tr>
<td>Copy</td>
<td>-C</td>
<td>Places a copy of the region onto the clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>-V</td>
<td>Merges the clipboard onto a track beginning at the In point. Sync is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>unchanged.</td>
</tr>
<tr>
<td>Delete Time</td>
<td>-D</td>
<td>Removes a region from the track to the clipboard.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The sync of the following events is changed.</td>
</tr>
<tr>
<td>Insert</td>
<td>-I</td>
<td>Adds the clipboard into the track at the In point, changing the sync of</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the following events.</td>
</tr>
<tr>
<td>Insert Leader</td>
<td></td>
<td>Adds leader into a selected region.</td>
</tr>
<tr>
<td>Fill</td>
<td>-F</td>
<td>Pours the clipboard into a region, deleting any previous events.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the clipboard length is longer than the region, as much of the region</td>
</tr>
<tr>
<td></td>
<td></td>
<td>as possible is filled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the clipboard length is shorter than the region, a dialog presents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the options loops fill or fill as much as possible. Sync is unchanged.</td>
</tr>
<tr>
<td>Fill with Leader</td>
<td>-E</td>
<td>Pours leader into a region. Deletes overlapping events. Sync is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>unchanged.</td>
</tr>
<tr>
<td>Extract</td>
<td></td>
<td>Deletes everything on a track except what is between the In and Out</td>
</tr>
<tr>
<td></td>
<td></td>
<td>point. Sync is unchanged.</td>
</tr>
<tr>
<td>Exchange</td>
<td></td>
<td>Swaps a region on a track with the clipboard. Sync changes.</td>
</tr>
</tbody>
</table>
**Playback**

**Motion Controls**

You can play the sequence by holding down the Control key while double-clicking in the tracks display at the point where you want to begin playback. The following motion controls are also available.

<table>
<thead>
<tr>
<th>Key</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>F9</td>
<td>Play from selected handle or time field</td>
</tr>
<tr>
<td>F10</td>
<td>Stop</td>
</tr>
<tr>
<td>F11</td>
<td>Play to selected handle or time field</td>
</tr>
<tr>
<td>F12</td>
<td>Audition the event or region</td>
</tr>
</tbody>
</table>

Select the tool to forward or reverse the sequencer. The farther left or right you drag in the track display, the faster the sequencer shuttles.

If you do not want the display to scroll while the sequencer is playing, select **Lock Display** from the Controls menu to freeze it, or select **Page Display** to page instead of scroll.

The current cursor location is displayed in the upper left corner of the EditView window.
Select **Locate to Mark**, **Locate to In** or **Locate to Out** from the Controls menu to locate to the Mark, In or Out points. You can also locate to the mark by pressing the Control key and then pressing the up arrow twice. To locate to any time field, hold down the Control key and click in the time field.

**Scrubbing**

Scrubbing in EditView is similar to scrubbing over audio tape. It is used for finding an edit point in the event or sequence. (Notes are not triggered during scrubbing, only cues.) To scrub, drag the cursor back and forth across the track display. Audio under the cursor is played.

When you start scrubbing on an event, the event is selected and only the audio associated with that track is played. When you start scrubbing outside an event, the sequence is scrubbed; any selected event is deselected and all tracks are scrubbed.

After locking to the In, Out, or Mark point, the cursor scrubs the selected time. To return to track or sequence scrubbing, deselect the In, Out or Mark time. (The icons on the ruler do not scrub is dragged manually.)

There are two scrubbing modes—normal and fine. To access the find scrubbing mode, hold down the Shift key.

RAM events do not scrub.

**Solo and Mute**

To the left of the track numbers are **Solo** and **Mute** buttons which toggle off and on. Click a Solo button (green when lit) to hear audio only from that track. Click a Mute button (red when lit) to prevent hearing audio from that track.

The **Master Solo** and **Master Mute** buttons light when any track is soloed or muted. Click the Master Solo button (green when lit) to clear all solos. Click the Master Mute button (red when lit) to clear all mutes.
You can also select **Clear Solos** and **Clear Mutes** from the Controls menu to clear all track solos and mutes.

When scrubbing a track, its solo button light automatically. When you stop scrubbing, the track is no longer soloed.

---

**Mark Point**

There is one Mark point in EditView. It can be used to locate to

- Type a time into the Mark time field.
- Drag the Mark icon on the ruler.
- Select Take Mark (F13) from the Times menu.

Select the **Lock to Mark** command in the Times menu to lock the trackball to the Mark point, which allows you to scrub the time.

Three commands in the Events menu use the mark point to move a mark point or to move a handle.

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trim to Mark</td>
<td>Trim current handle to Mark point.</td>
</tr>
<tr>
<td>Move Mark to In</td>
<td>Move Mark point to In point.</td>
</tr>
<tr>
<td>Move Mark to Handle</td>
<td>Move Mark point to selected handle.</td>
</tr>
</tbody>
</table>

---

**Output Routing**

Select the EditView Control menu command **Show Output Routings** to display and/or change track routing. The window expands to show left and right channel routing. Select an output field and type a new number.

You can route any track to any output at any time as long as you do not exceed four events per drive in a MaxTrax configuration and two events per drive in any other configuration.
Autoconform is used to record source audio defined by an edit decision list onto the Direct-To-Disk DTD and assemble the audio into an NED sequence.

Opening an EDL

Autoconform is an NED application with a set of pulldown menus that appear when Autoconform is active. To open Autoconform, either double-click the application icon on the desktop or select Autoconform from the Window menu.

Autoconform can open CMX compatible files. When you first open Autoconform, a dialog box appears. To open an Autoconform EDL file, use the dialog to navigate to the appropriate file and open it.

If you want to open a file on a CMX disk, click Cancel in the dialog, and select Open CMX... from the File menu. Insert the 3.5” CMX disk. (You must select Open CMX... before inserting the disk.) The file you select from the dialog is converted into an Autoconform file that appears in the Autoconform window. The Autoconform filename automatically corresponds to the CMX filename.

When reading a CMX list into an Autoconform EDL, the system automatically cleans the list and eliminates unneeded events. If audio overlaps, an event may be separated into multiple events. For example—
The Autoconform Window

The **Title** field displays the title that appears in the CMX project. The **Time** field displays the current time code location on the source machine during recording. During conforming, the current sequence time is displayed.

The **reel list** lists the source reels included in the EDL. The **EDL** lists the events requiring audio from the source reels.

To specify what information is displayed in the EDL, choose **Preferences...** from the Window menu and check the desired options. The selected sort field is underlined in the EDL. Select the video format that was used when the source reels were created. **Set Default** saves these preferences as your default setting for the current EDL file. **Revert** recalls the current default settings at any time.
The Reel List

To select a source reel, click its name in the reel list. Events required from the selected reel appear in the EDL. When All Reels is selected, the entire EDL is displayed.

The status box next to the reel name indicates whether audio on that reel has been recorded onto the DTD. A reel can have one of three status states—

<table>
<thead>
<tr>
<th>Status Box State</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red.</td>
<td>None of the required audio from the source reel has been recorded into the current project on the DTD.</td>
</tr>
<tr>
<td>Green.</td>
<td>All of the required audio from the source reel has been recorded into the current project on the DTD.</td>
</tr>
<tr>
<td>Yellow.</td>
<td>Some of the required audio from the source reel has been recorded onto the DTD. This status may appear during recording, when you abort recording or when changes to the EDL require new audio from a previously-recorded source reel.</td>
</tr>
</tbody>
</table>

The EDL

The status box next to each event indicates whether the audio associated with that event has been recorded.

To select one or more events for recording or conforming—

- To select a single event, click its event number.
- To select all the events between two events, either drag from one event to the other or press and hold the Shift key while you click the two events names.
- To select a group of non-contiguous events, press and hold the key while you click each desired event name.

Motion Controls

Use the following key equivalents to operate the sequencer motion controls. If machine control is turned on, the commands control the external machine.

- Stop
- Play
- Fast Forward
- Rewind
Setting Up To Record

Editing the EDL

You can edit many of the fields in an Autoconform list: source in, source out and duration times; destination in, destination out and duration times; destination track number; channel number; and fade times. This can be done by clicking on the field and typing a new entry. It can also be done using the Edit menu commands—Copy, Cut and Paste—to select a field and then pasting at the cursor location.

Once a list has been opened and edited in Autoconform, any changes you make are not exported back to the original text file. The changes are only visible when you run Autoconform. If you use a word processing program to make changes, any changes made in Autoconform will be lost.

Track Assignments

The Dest Tracks column lists the DTD tracks on which the cues are recorded. By default, the destination track numbers are the same as the source channel numbers. For example, all mono events on source channel 2 will be recorded onto DTD track 2. For a multichannel event, all relevant tracks are listed.

Changing a channel number automatically changes the destination track number to match.

Press to edit the track assignment of the next event, or to edit the track assignment of the previous event. You can change track assignments automatically by using the checkerboard feature, described below.

Checkerboarding

Checkerboarding places events from one source channel onto two or more destination tracks. Select the desired reel and then select Checkerboard Events... from the Events menu. (If any events of the currently displayed reel are selected, the menu item becomes Checkerboard Selected Events... and checkerboarding will affect only those events.) To checkerboard the events of all reels in the EDL, select All Reels before selecting the checkerboard command.

In the checkerboard dialog, select the source channel(s) whose events you want to separate. In the column labeled Dest Tracks, enter the range of destination tracks for each selected channel. The following example illustrates different track assignments.
Two-channel events require an even number of destination tracks. The destination tracks are adjacent, regardless of whether the source channels are. The lowest source channel is automatically assigned to the lowest track of each destination pair.

<table>
<thead>
<tr>
<th>Source Channels</th>
<th>Best Tracks First</th>
<th>Last</th>
<th>Separates events onto Direct-to-Disk tracks</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ 1</td>
<td>1</td>
<td>3</td>
<td>1 &amp; 2 &amp; 3</td>
</tr>
<tr>
<td>☑ 2</td>
<td>3</td>
<td>1</td>
<td>3 &amp; 2 &amp; 1</td>
</tr>
<tr>
<td>☑ 3</td>
<td>5</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>☑ 4</td>
<td>3</td>
<td>1</td>
<td>not separated</td>
</tr>
<tr>
<td>☑ 1,2</td>
<td>1</td>
<td>6</td>
<td>1,2 &amp; 3,4 &amp; 5,6</td>
</tr>
<tr>
<td>☑ 1,3</td>
<td>1</td>
<td>6</td>
<td>not separated</td>
</tr>
<tr>
<td>☑ 1,4</td>
<td>6</td>
<td>1</td>
<td>5,6 &amp; 3,4 &amp; 1,2</td>
</tr>
<tr>
<td>☑ 2,3</td>
<td>5</td>
<td>6</td>
<td>5,6</td>
</tr>
<tr>
<td>☑ 2,4</td>
<td>6</td>
<td>5</td>
<td>5,6</td>
</tr>
<tr>
<td>☑ 3,4</td>
<td>6</td>
<td>5</td>
<td>not separated</td>
</tr>
</tbody>
</table>

Set Default saves these track assignments as your default setting for all EDL files. Revert recalls the current default settings at any time.
Recording

Once you have an EDL in Autoconform, you can record required audio from the source reels onto the DTD and assemble the audio into a sequence that conforms to the list.

Recording Preferences

Before recording source audio to the DTD, you can set a number of record options by selecting the Record menu Record Preferences... command—

<table>
<thead>
<tr>
<th>Record Preferences</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Head: 2.0</td>
</tr>
<tr>
<td>Tail: 2.0</td>
</tr>
<tr>
<td>Options:</td>
</tr>
<tr>
<td>□ Autoconform after record</td>
</tr>
<tr>
<td>□ Cue Stramp studio computer</td>
</tr>
<tr>
<td>□ Maintain sync during record</td>
</tr>
<tr>
<td>Machine Control:</td>
</tr>
<tr>
<td>Protocol:</td>
</tr>
<tr>
<td>○ None ○ Sony ○ Ampex</td>
</tr>
<tr>
<td>Machine Address: 1</td>
</tr>
<tr>
<td>Port:</td>
</tr>
<tr>
<td>○ Modem ○ Printer ○ E ○ F ○ G ○ H</td>
</tr>
<tr>
<td>Timecode:</td>
</tr>
<tr>
<td>○ Continuous ○ Discontinuous</td>
</tr>
<tr>
<td>Preroll: 5</td>
</tr>
<tr>
<td>Routing:</td>
</tr>
<tr>
<td>Source Channel 1 2 3 4</td>
</tr>
<tr>
<td>Input:</td>
</tr>
<tr>
<td>STM 1A STM 1B STM 1C STM 1D</td>
</tr>
</tbody>
</table>

Record Head/Tail

Indicates the number of seconds of additional audio recorded before and after each event. Accurate to one millisecond (e.g., 2.500)

Options

Autoconform after record

Reel or selected events are conformed immediately after being recorded. Select “Conform Preferences” from the Conform menu to specify conform options before recording.

Cue Stramp studio computer

This option must be checked in order to use the Stramp SR System (Taker Box).

Maintain sync during record

If this option is on, the SMPTE offset is unchanged during recording, so the source and destination sync times are identical. This is useful during ADR.

If this option is off, the SMPTE offset is changed to about 15 seconds before the Destination In time prior to each recording. This is because the DTD will not record audio if the source time is much greater than the SMPTE offset time.
### Machine Control

**Protocol**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Control of source machine is disabled. The reel can either be played from start to finish or shuttled by hand.</td>
</tr>
<tr>
<td>Sony</td>
<td>The reel autolocates using the Sony BVH machine control protocol.</td>
</tr>
<tr>
<td>Ampex</td>
<td>The reel autolocates using the Ampex VPR3 machine control protocol. In the Machine Address field, enter the address number of the machine you want to control.</td>
</tr>
</tbody>
</table>

**Port**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modem or Printer</td>
<td>The machine control cable is connected to the Macintosh modem port or printer port. Make sure you select the Macintosh port that is connected to the source machine (not the port connected to the DTD).</td>
</tr>
<tr>
<td>C, D, E or F</td>
<td>The machine control cable is connected to the Nubus serial ports C, D, E or F. These serial ports can be added to the Macintosh by purchasing a “Hurdler Dual Serial” or “Hurdler Quad Serial” board to add 2 or 4 ports respectively.</td>
</tr>
</tbody>
</table>

**Timecode**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous</td>
<td>The system expects continuous ascending time code within a 24-hour clock matching the EDL. If you select this option, the search speed (for Sony protocol) is much faster than with discontinuous time code.</td>
</tr>
<tr>
<td>Discontinuous</td>
<td>The system expects discontinuous ascending time code within a 24-hour clock starting at a specified time and matching the EDL. If you plan to record with this option, you must select the Settings command on the RTP Sequence Editor and set the SMPTE Resync to ON before you set the timecode option in the Record Preferences dialog box.</td>
</tr>
</tbody>
</table>

**Preroll**

Indicates the number of seconds allowed for the tape machine to reach speed.

**Routing**

Available inputs appear on pop-up menus. Select the DTD input you are using for each source channel.

The **Set Default** button saves these preferences as the default for all EDL files. The **Revert** button recalls the current default settings at any time.
Recording

Before recording, create or recall a DTD project. The preferred track mode during recording is CuePB.

To avoid slowing down the system, you can erase any previous sequence. Do not erase the sequence if you are going to merge events.

Reels are recorded onto the DTD one at a time. If All Reels is selected, the entire EDL is displayed but the record commands are unavailable.

You can record an entire reel or individual events—

- To record all enabled events from a reel, select the desired reel and then select Record Reel from the Record menu. (Current sequence is erased.)
- To record only specific events in the EDL, select those events and then choose Record Selected Events from the Record menu. (Does not erase current sequence.)
- To record all except the selected events, choose Disable Selected Events from the Events menu before recording. Disabled events are greyed out. Use the Enable Selected Events command to reactivate disabled events.

All events are automatically enabled whenever an EDL file is opened.

After you select Record Reel or Record Selected Events, a dialog asks if you want to erase the current sequence. If you click “Erase,” the sequence is erased before recording begins. “Don’t Erase” leaves the current sequence intact. (See “Conforming” below.)

If machine control is in use, the system locates the audio on the source reels and proceeds to record each audio event as a cue into the current project on the DTD. To abort recording at any time, press - period (.) or select Stop Recording from the Record menu.

Whenever the reel reaches a break in the timecode while recording, the DTD stops recording and saves a cue. The system may choose to record multiple events with consecutive source times which use the same channels as a single cue.

Cue names are automatically assigned to each recorded event. The cue name consists of the reel name followed by a space and a unique three-digit take number, unrelated to the source event number (e.g., REEL2 013).

The cues on the DTD are synced to the source reel. To preserve the synchronization when the EDL is conformed, do not modify or resave cues that you want to conform.
Recording Multiple Takes

In some cases you may want to record multiple takes of the same event. Select the event that you want to record and then choose **Duplicate Selected Events** ( -D) from the Events menu. Each time you select the command, an additional event is created. The duplicate events have the same event name, but with the suffix A, B, C, etc.

Record the duplicate takes. To indicate which take(s) will be conformed, first select **Preferences...** from the Window menu and check “Conform Selector.” This displays a conform box next to each duplicate event in the EDL. Click the box of any take(s) you want to conform.

```
original event  event to conform
duplicate events
```

Rehearsing Events

Rehearse mode is used when an actor is recording a take live; the audio is not being transferred from a source reel. There are two Record menu commands used for rehearsing events before recording: **Rehearse Mode** ( -T) and **Rehearse Loop** ( -L). A check mark indicates when they are on. Rehearse Mode must be on in order to use Rehearse Loop.

In Rehearse Mode, when you select a record command, Autoconform goes into rehearse instead of record at the In time and goes out of rehearse at the Out time. No recording takes place, but the destination track(s) switch in and out of Input mode during the interval when recording would take place.

Rehearse Loop repeatedly rehearses the selected events. Rehearsing continues until you turn off Rehearse Mode and return to the first looped event, at which time you go into record automatically. To stop rehearsing or recording, press -period (.)

Use -T to tell the system that the current rehearse loop is the last one and to begin recording the selected events the next time around the loop.

Usually, all DTD tracks should be placed into CuePB mode before using rehearse. You should also select the **Record Preferences...** command from the Record menu and select “Maintain Sync During Record.”
Using the Stramp SR System

The Stramp SR System (the Taker Box) manufactured in Germany is used to automatically cue actors when they are doing dialog replacement. The following diagram details how to setup the Taker Box to use it with the DTD.

![Diagram of Stramp SR System setup]

During operation of the Taker Box, a red light plugged into a LitCube may be used to indicate a window of time from four seconds before a take to two seconds after the take. To operate, the LitCube’s control cable must be plugged into DB1 on the Taker Box. However, this is also the connection used by the D34 GPI in the NED control unit to connect to the Taker Box. In order to use the LitCube and also remain connected to the GPI, you must make or purchase a Y-cable that has at one end a male connector for the DB-25 socket in the Taker Box; the other end branches into two female connectors, one for the GPI and one for the LitCube. The GPI interface uses pins 4, 5, 16 and 17. The LitCube uses pins 8 and 21.

If you are using the Taker Box, you must select “Cue Stramp studio computer” from the Record Preferences dialog.
Erasing Audio

After recording, you can erase selected cues from the DTD tracks. In the EDL, select the event(s) whose audio you want to erase, and select Erase Selected Audio... from the Record menu.

The dialog indicates the name of the cue to erase, how many source events are contained in the cue, and the Source In (and Out) time of the first (and last) event in the cue.

Click one of these buttons—

- **Erase Cue**: Deletes the cue from the DTD. If the number of events in the cue is more than 1, audio from several source events is erased. Any sequence events that reference the deleted cue are automatically deleted from the sequence.

- **Retake**: Deletes the cue from the DTD and re-records the source audio. If “Autoconform After Record” is selected from the Record Preferences, the new cue is automatically replaced in the sequence.

- **Skip**: Leaves the cue intact and displays the dialog for the next selected event.

- **Cancel**: Closes the dialog box without erasing the cue.

If you erase audio that is at the end of a project track, the disk space can be used for recording again. If, however, you erase audio in the middle of a recorded track, the disk space cannot be reclaimed.
Conforming

Once audio has been recorded onto the DTD, you can assemble it into a sequence that conforms to the list. This can be done automatically after recording, or manually.

Turning the EDL Into a Sequence

Once the audio from the EDL has been recorded to the DTD, you can conform it into a sequence. You can begin conforming before recording all the reels, but only the events recorded to the DTD will be conformed.

Before you conform, select Conform Preferences... from the Conform menu. Specify which, if any, sequence track will receive video events.

If you selected “Autoconform after record” when you set the Record Preferences, conforming will take place automatically after recording. Because of this, you should also set the Conform Preferences prior to recording.

The destination tracks listed in the EDL must be the same as the DTD tracks on which the event was recorded. Each multitrack event is listed on the lowest corresponding sequence track.

To conform audio manually, first click the name of the source reel you want to conform. (You cannot conform if All Reels is selected) then—

- To conform all enabled events, select Conform Audio from the Conform menu. (Current sequence is erased.)
- To conform only specific events, select those events and then choose Conform Selected Events from the Conform menu. (Current sequence is not erased.)
- To conform all except the selected events, choose Disable Selected Events from the Events menu before conforming. Use the Enable Selected Events command to reactivate disabled events.

To abort conforming at any time, press -period (.) or select Stop Conforming from the Conform menu. You can use either EditView or the RTP Audio Event Editor to edit the resulting sequence. The Event Start time of each event in the sequence is the same as the Destination In time of the corresponding event in the EDL. The caption for each sequence event includes the CMX event number.

Merging Events

After you select a Conform command, a dialog asks if you want to erase the current sequence before creating a new one.
If you click “Erase,” the previous sequence is erased, and the conformed sequence contains only video events and the audio events that have been recorded to the DTD as cues.

You may, however, want to merge the conformed sequence with the events in the current sequence. If so, make sure that the SMPTE modes of the existing sequence and the CMX EDL’s destination or master reel match, and the SMPTE offset of the sequence is before the first event. Then click “Don’t Erase” from the dialog.

If you are building a sequence event by event, you should conform the earliest event first with the “Erase” option. This will set both SMPTE offset and mode correctly for the list. Remaining events can then be conformed in any order.

An easy way to find the first event is to sort the EDL by “Destination In.” The first event will then be at the top of the list.
Menus

The following is an explanation of the menu commands that are available when Autoconform is active.

**File Menu**

- **Open...** 
  - Opens a CMX list which has already been converted to an EDL file.

- **Open CMX...**
  - Opens a CMX disk that has not yet been converted to an EDL file.

- **Close**
  - Closes the current EDL file.

- **Save**
  - Saves the current EDL file to disk. A previously-saved file has its changes saved; the Save As dialog appears for an untitled file.

- **Save As...**
  - Lets you name and save an untitled file or rename a previously-saved file.

- **Close Conform**
  - Closes Autoconform while remaining in the Real-Time Performance system.

- **Quit**
  - Exits Autoconform.

**Edit Menu**

- **Undo**
  - Currently is not functional.

- **Cut**
  - Removes the selection and places it on the Clipboard.

- **Copy**
  - Places a copy of the selection onto the Clipboard.

- **Paste**
  - Places the Clipboard contents into the selection.

- **Clear**
  - Removes the selection without placing it on the Clipboard.

**Window Menu**

- **Preferences...**
  - Lets you select display and sorting options for the EDL and specify the video format used to create the source events.

- **Filenames**
  - Open EDL files are listed. The current file is checked.
Events Menu

Disable Selected Events
Prevents events from being checkerboarded, recorded or conformed.

Enable Selected Events
Allows events to be checkerboarded, recorded or conformed.

Duplicate Selected Events -D
Makes a copy of the selected event(s).

Checkerboard Events...
Lets you route source channels to a range of destination tracks.

Record Menu

Record Reel
Begins recording audio from the selected reel onto the Direct-to-Disk. During recording, the command toggles to Stop Recording.

Record Selected Events
Begins recording only the selected events from a reel onto the Direct-to-Disk.

Rehearse Mode -T
In this mode, no recording takes place but the destination tracks switch in and out of Input mode.

Rehearse Loop -L
In this mode, rehearsing continues in a loop until you turn Rehearse Mode off. (Rehearse Mode must be on in order to use this command.)

Erase Selected Audio... -E
Lets you erase selected cues that have been recorded on the Direct-to-Disk tracks.

Record Preferences...
Lets you specify record head and tail amounts, machine control options and input routing.

Show History
Currently is not functional.

Conform Menu

Conform Audio -A
Creates a sequence that conforms to the EDL. Only cues on the Direct-to-Disk and video events are conformed. During conforming, the command toggles to Stop Conforming.

Conform Selected Events
Creates a sequence containing selected events of an EDL. Only cues on the Direct-to-Disk and video events are conformed.

Conform Preferences...
Lets you specify which sequence track, if any, will receive video events.